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About this Guide 
This document provides configuration instructions for SAS 9.1.3 Foundation, which is made up of 
server-side Base SAS and a variety of server-side SAS products (the exact products vary by 
customer). Information about the configuration of mid-tier and client-side products are available 
from your SAS Software Navigator. 

The server-side configuration instructions contained in this document are for the configuration of 
a generic SAS server.  

• For information about configuring OLAP, workspace and stored process servers, please 
see SAS Integration Technologies: Server Administrator's Guide.  

• For information about setting up a metadata server, please see SAS 9.1.3 Intelligence 
Platform: System Administration Guide.  

This material can be found at 
http://support.sas.com/documentation/configuration/index.html. 
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Chapter 1: SAS/ACCESS Interfaces 

Configuring SAS/ACCESS Interface to MySQL Software 
Before you can use SAS/ACCESS Interface to MySQL software, the following products are required: 

• Base SAS software 
• SAS/ACCESS Interface to MySQL software 

Before you use SAS/ACCESS interface to MySQL software, verify that the MySQL client library has 
been appended to Path, a system variable. The MySQL client library is often located in 
C:\mysql\bin.  

To locate the Path system variable, follow the instructions for your operating system.  

• For Windows NT, right-click My Computer and choose Properties. Select the 
Environment tab and you will see in your list of system variables.  

• For Windows 2000, right-click My Computer and choose Properties. Select the 
Advanced tab and select the Environment Variables button. You will see Path in your 
list of System Variables.  

• For Windows XP, click Start then select Control Panel. Double-click System. Select the 
Advanced tab and select the Environment Variables button. You will see Path in your 
list of System Variables. 

If you use MySQL Client version 4.1.0 or later, you will need to make a change because of client 
incompatibilities. The SASMYL SAS option must be updated so that the SAS/ACCESS Interface to 
MySQL can identify your version of the MySQL client. This can be done either in the beginning of 
your SAS program or in your SASV9.cfg file.  

If you want to set the SASMYL option in your SAS Program, add the following line at the top of your 
SAS program: 

options set=SASMYL MYWIN417  

The SASV9.cfg file is located in your !SASROOT directory. To set the SASMYL SAS option in your 
config file, add the following line 

-set SASMYL MYWIN417 

For more information about SAS/ACCESS Interface to MySQL, refer to the MySQL chapter in 
SAS/ACCESS 9.1 for Relational Databases: Reference. 

Configuring SAS/ACCESS Interface to ODBC Software 
Before you can use SAS/ACCESS Interface to ODBC software, the following products are required: 

• Base SAS Software 
• SAS/ACCESS Interface to ODBC Software 
• A 32-bit ODBC driver for the source from which you want to access data 

The ODBC solution allows different technologies to be used by defining a standard interface. 
SAS/ACCESS Interface to ODBC software with ODBC drivers provides you with access to different 
databases. An ODBC driver processes ODBC function calls from--and returns results to--
SAS/ACCESS software. You can get drivers from Microsoft, your database vendor, or other third party 
software vendors. 
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To run SAS/ACCESS software on 32-bit Windows, you need 32-bit drivers. The application calls the 
32-bit Driver Manager (ODBC32.DLL), which in turn calls the 32-bit drivers. The following figure 
illustrates the architecture: 

SAS/ACCESS

32-Bit Driver Manager
(ODBC32.DLL)

32-Bit Driver32-Bit Driver 32-Bit Driver

Data Source Data Source Data Source
 

 

The ODBC Driver Manager and Administrator are Microsoft products that are included with all ODBC 
drivers. When you install an ODBC driver, the ODBC Driver Manager and Administrator are also 
installed. The ODBC Administrator should appear as an icon in the control panel. However, it can 
appear as an icon in the Start menu instead. 

After you install the ODBC driver, you can use the ODBC Administrator to define and manage the 
data sources. A data source associates a particular ODBC driver with the data you want to access 
through that driver. It can consist of information about the data you want to access and its associated 
operating system, DBMS, and network platform (if any) used to access the DBMS. For information 
about how to configure your data sources, refer to the documentation provided with your ODBC 
drivers. 

For more information about SAS/ACCESS to ODBC, refer to the ODBC chapter in SAS/ACCESS 9.1 
for Relational Databases: Reference. For more information about ODBC, refer to Microsoft ODBC 
3.0 Programmer’s Reference and SDK Guide. 

SAS/ACCESS ODBC Conversion Utilities 
The SAS/ACCESS ODBC Conversion Utilities are included in the SAS/ACCESS Interface to ODBC 
software. It helps users of Version 6 SAS/ACCESS Interface to AS/400 and SAS/ACCESS Interface to 
Microsoft SQL Server move from a native DBMS interface connection to an ODBC interface 
connection on SAS 9.1.3. 

AS/400 Users 
Before you can use the ODBC Conversion Utilities for AS/400 Interface, you need to install IBM’s 
Client Access ODBC Driver (32-bit) V3.00.0004 or above. If your AS/400 Client Access installation 
loaded a Client Access ODBC Driver prior to this release, you can download Program Temporary Fix 
(PTF) SF59504 or later from ftp://ftp.software.ibm.com/ for an update. This service pack for 
the Client Access product can be found in the 
/as400/products/clientaccess/win32/v3r1m2/servicepack/ directory. When this update 
is applied, Version 3.00.0004 or later of the ODBC driver should be installed. 

You are also required to create a data source name. You can use the ODBC administrator to add it. 
The data source name AS400 is recommended. If you want to use another data source name, set the 
SAS environment variable AS400DSN, located in your sasv9.cfg, to the data source name you 
assigned. Quotes are required if blanks or special characters are included. You may want to create it as 
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a system DSN instead of a user DSN if you have more than one user who might want to use the same 
workstation to access the AS/400 database. 

Complete the following steps to create a data source for AS/400 database access: 

1. Run ODBC Administrator from the Control Panel or Start menu: Start > Settings > 
Control Panel > (Admin Tools> on XP) Data Sources (ODBC). 

2. Click the User DSN or System DSN tab, depending on the number of users. 

3. Click the Add button and then choose Client Access ODBC driver (32-bit) from the pop-up 
windows. 

4. Click Finish. This brings up the Setup dialog. 

5. Click the General tab and enter AS400 (or another name) in the Data Source Name field. 
This name needs to match the value you set for the SAS environment variable AS400DSN.  

6. From the pull-down menu, choose an AS/400 system that you want to connect to using this 
data source. 

7. To change the method that this data source will use to connect, click Connection Options. 
Select the appropriate option and click OK. 

8. Click the Server tab. The default library is QGPL. You can change this designation by 
deleting its name from under the Default Libraries filed and either entering a new library to 
use or leaving it blank. 

9. Click the Format tab. Using the Naming Convention pull-down list, select System naming 
convention (*SYS). 

10. Click the Package(s) tab. Uncheck the box for Enable Extended Dynamic Support. 

11. Click OK to close the Setup window. 

Microsoft SQL Server Users 
An ODBC Conversion Utility is provided that will allow you to read SAS System Version 6 views to 
access data in Microsoft SQL Server which were created with SAS/ACCESS Interface to Sybase and 
SQL Server software on Windows. The Conversion Utility helps users migrate to SAS/ACCESS 
Interface to ODBC software on Windows. 

Note: The Conversion Utility applies only to views that access data in Microsoft SQL Server. It 
does not apply to SYBASE SQL Server.  

The ODBC Conversion Utility requires the Microsoft SQL Server ODBC driver (32-bit) from 
Microsoft. This driver is installed as part of Microsoft Data Access Components (MDAC). 

It is recommended (but not required) to create a data source name. You can use ODBC administrator 
to add it. You must set the SAS environment variable MSSQLDSN, located in the sasv9.cfg, as the 
data source name you assigned. Quotes are required if blanks or special characters are included. You 
can create it as a system DSN instead of a user DSN if you have more than one user who may use the 
same workstation to access the Microsoft SQL Server database. 

Complete the following steps to create a data source for Microsoft SQL Server database access: 

1. Run ODBC Administrator from the Control Panel or Start menu. 

2. Click the User DSN or System DSN tab, depending on the number of users, as stated 
above. 

3. Click the Add button and choose SQL Server from the pop-up window. 

4. Enter any name in the Name field. This name needs to match the value you set for the SAS 
environment variable MSSQLDSN. 



Post-Installation Guide for SAS 9.1.3 Foundation for Microsoft Windows 

4 

5. Choose or enter the Server field which you defined using SQL Client Configuration Utility. 

6. Click Next. Select the radio button that describes your login method. If necessary, enter a 
login ID and password. 

7. Click Next. A connection will be initiated. If the connection succeeds, please refer to Step 8 
below. If the connection fails, an error message will provide a reason for the failure. 

8. After a connection succeeds, your default databases may be changed. Click Next to leave this 
screen. 

9. After changing your default databases, other options may be selected. Click Finish when this 
screen is correct. 

10. Click Test Data Source. After a message appears that indicates that the test was successful, 
click Okay. Click Okay on the following message as well. 

Note: SAS 9.1.3 will automatically install Microsoft Data Access Components (MDAC) when you 
install SAS/ACCESS Interface to ODBC software. 

Configuring SAS/ACCESS Interface to Oracle Software 
Before you can use SAS/ACCESS Interface to Oracle software, the following products are required: 

• Base SAS software 
• SAS/ACCESS Interface to Oracle software 
• Oracle Server, Release 8.1.7 or later 
• Oracle Client, Release 8.1.7 or later 

Assigning the Default Path for the Oracle Server 
When you use SAS/ACCESS interface software without specifying any PATH statement/field, 
SAS/ACCESS software uses the defined default path. 

Complete the following steps: 

1. Run Windows registry editor (REGEDIT). 

2. Select HKEY_LOCAL_MACHINE > SOFTWARE > Oracle. 

Note:  If you are using the ORACLE8i client, the sequence in Step 2 above ends with an 
additional selection > HOME0. 

3. Select Edit > New > String Value. 

4. Enter LOCAL as the Value Name and then select Edit > Modify. 

5. The Value Name field now says Local. 

6. Enter your connect-string for the Value Data field in the pop-up dialog box. 

7. Select OK. 

For more information about SAS/ACCESS Interface to Oracle, refer to the Oracle chapter in 
SAS/ACCESS 9.1 for Relational Databases: Reference. 

Configuring the SAS/ACCESS Interface to PeopleSoft 
Refer to the SAS 9.1.3 Foundation for Microsoft Windows System Requirements for information 
about the SAS/ACCESS products required for access to the underlying PeopleSoft database. 

The SAS/ACCESS Interface to PeopleSoft requires that a libname statement be executed prior to 
running the application. This libname statement produces a libref to the database where the 
PeopleSoft data resides.  
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Here is an example of the libname statement: 

libname psdb oracle user=userid pass=pass 
path='dbpath'; 

Configuring SAS/ACCESS Interface to R/3 Software 
SAS/ACCESS Interface to R/3 software requires extensive installation setup before it can be used. 
Refer to the Installation Instructions for SAS/ACCESS 4.2 Interface to R/3 included in your SAS 
software order for detailed installation instructions and configuration information. 

Configuring SAS/ACCESS Interface to SAP BW Software 
SAS/ACCESS Interface to SAP BW software requires extensive installation setup before it can be 
used. Refer to the Installation Instructions for SAS/ACCESS Interface to SAP BW included in your 
SAS software order for detailed installation instructions and configuration information. 

Configuring SAS/ACCESS Interface to SYBASE Software 
In SAS 9.1.3, the administrator or user must install a Sybase-stored procedure on the target server. 
Two files have been included in the !SASROOT\access\misc directory to assist in the installation: 

• sas-spcp.txt is a text file containing instructions on how to do the installation.  

• sas-spdf.txt is the actual stored procedure script. The process utilizes two Sybase 
facilities, defncopy and isql. 

Configuring SAS/ACCESS Interface to Teradata Software 
Before using SAS/ACCESS Interface to Teradata software, you should verify connectivity by logging 
into your Teradata account with the Teradata BTEQ utility. If BTEQ is unavailable, establish 
connectivity as documented in the SAS/ACCESS to Teradata white paper, available at 
http://support.sas.com/techsup/technote/ts713.pdf. 

If BTEQ fails to connect to the Teradata server, you may need an entry in the hosts file on your PC to 
provide the network address of the Teradata server. Typically, this means adding a dbccop1 entry to 
your hosts file. For more details about the entry, see your Teradata Client for Windows Installation 
Guide.  

If after performing these steps, you encounter problems using SAS/ACCESS, verify that you have 
installed the efix DR47606. To run SAS/ACCESS successfully, you must install this Teradata fix for 
any Teradata client version earlier than TUF 6.0. 

FastExporting 
For optimal reads of large tables, SAS/ACCESS can perform FastExporting. To perform 
FastExporting, the Teradata FastExport Utility must be present on the system where you install SAS. 
You must also modify Path, a system variable. Append two directory paths to the end of Path: 

1. The directory where fexp.exe (the FastExport Utility) is located. Often this is C:\Program 
Files\NCR\Teradata Client\bin. 

2. The directory where sasaxsm.dll is located (sasaxsm.dll is usually located in your SAS 
product tree, in the !sasroot\core\sasext directory.) 

To locate the Path system variable, follow the instructions for your operating system: 

• For Windows NT, right click My Computer and chose Properties. Select the 
Environment tab and you will see Path in your list of System Variables.  



Post-Installation Guide for SAS 9.1.3 Foundation for Microsoft Windows 

6 

• For Windows 2000, right-click My Computer and chose Properties. Select the Advanced 
tab and select the Environment Variables button. You will see Path in your list of System 
Variables.  

• For Windows XP, click Start then select Control Panel. Double-click System. Select the 
Advanced tab and select the Environment Variables button. You will see Path in your 
list of System Variables. 

The FastExport Utility is not required; SAS/ACCESS reads large tables quite efficiently without it. For 
further information, see the DBSLICEPARM option in your SAS/ACCESS to Teradata documentation. 
Contact NCR if you want to obtain the Teradata FastExport Utility. 

For more information about SAS/ACCESS Interface to Teradata software, please see the Teradata 
chapter in SAS/ACCESS 9.1 for Relational Databases: Reference, and the SAS/ACCESS to Teradata 
white paper, available on the SAS web site at 
http://support.sas.com/techsup/technote/ts713.pdf. 

MultiLoad 
SAS/ACCESS can load large volumes of data to non-empty tables using MultiLoad. To perform 
MultiLoading, the Teradata MultiLoad Utility must be present on the system where you install SAS. 
You must also modify Path, a system variable. Append two directory paths to the end of Path:  

1. The directory where mload.exe (the MultiLoad Utility) is located. Often this is C:\Program 
Files\NCR\Teradata Client\bin  

2. The directory where sasmlam.dll and sasmlne.dll are located (sasmlam.dll and 
sasmlne.dll are usually located in your SAS product tree, in the !sasroot\core\sasext 
directory.)  

To locate the Path system variable, follow the instructions for your operating system:  

• For Windows NT, right-click My Computer and chose Properties. Select the 
Environment tab and you will see Path in your list of System Variables.  

• For Windows 2000, right-click My Computer and chose Properties. Select the Advanced 
tab and select the Environment Variables button. You will see Path in your list of System 
Variables.  

• For Windows XP, click Start then select Control Panel. Double-click System. Select the 
Advanced tab and select the Environment Variables button. You will see Path in your 
list of System Variables.  

The MultiLoad Utility is not required; SAS/ACCESS provides other options for loading tables. For 
further information, see the MULTISTMT option in your SAS/ACCESS to Teradata documentation. 
Contact NCR if you want to obtain the Teradata MultiLoad Utility. 
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Chapter 2: Post-Installation Configuration for SAS AppDev 
Studio Software 

For information about how to configure your SAS AppDev Studio™ software after you have completed 
the installation of SAS 9.1.3 Foundation, please visit the SAS AppDev Studio Developer's Site, 
http://support.sas.com/rnd/appdev.  
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Chapter 3: Post-Installation Setup for SAS/ASSIST Software 
This chapter describes how to add an optional master profile to SAS/ASSIST software. You can use a 
master profile to override the default settings as sent by SAS. This allows you to provide a customized 
setup for SAS/ASSIST software. With the master profile, you can control the profile options of all 
SAS/ASSIST users from one central place. For information on the profile options, refer to 
SAS/ASSIST Administrator’s Guide. 

Adding a Master Profile 
Complete the following steps to add a master profile to SAS/ASSIST software: 

1. Specify the location of the master profile by creating a new directory that all users of 
SAS/ASSIST software will have read access to. 

All users with write access to this directory will automatically also have write access to the 
master profile in SAS/ASSIST software. Select a name that conforms to the naming 
conventions at your installation. The name of this new directory must be stored in an entry in 
the SASHELP library. This requires that you have write access to the SASHELP library. 

On line 1 of the Editor window of the SAS Display Manager System, type the physical 
pathname of the master profile directory. Execute the Save command to store this in the 
SASHELP.QASSIST catalog. For example: 

SAVE SASHELP.QASSIST.PARMS.SOURCE 
00001 S:\SAS\ASSIST\PARMS 
00002 
00003 

The location of the master profile is now known by SAS/ASSIST software. 

2. Create the master profile. 

The first time SAS/ASSIST software is started, a master profile is created if 
SASHELP.QASSIST.PARMS.SOURCE contains the name of an existing physical pathname, 
and the person who starts SAS/ASSIST software has write access to this physical pathname. 

3. Customize the master profile by starting SAS/ASSIST software and selecting Setup > 
Profiles > Master/group ... 

If you have write access to the SAS library containing the master profile, you can specify 
default values for your installation. New users will use these values as they start SAS/ASSIST 
software. 

Note: If you restrict values by typing R in Status, users will not be allowed to change the 
values you define. 

You can run SAS/ASSIST software in two different styles - workplace or block menu. The 
block menu can be new style or old style. You can control this using the profile options below. 

Run workplace: 
SAS/Assist style:  Workplace 
Run block menu new style: 
SAS/Assist style:  Block Menu 
Save selections on end: Yes 
Menu Style:   New 
Run old style: 
SAS/Assist style:  Block Menu 
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Save selections on end: Yes 
Menu Style:   Old 

By setting the default values in the master profile, you can control if users should use the new 
or old style of SAS/ASSIST software. In addition, there are many other profile options. For 
more information on these options, refer to SAS/ASSIST Administrator’s Guide. 

4. Create group profiles. 

From the master profile, it is possible to create group profiles to allow groups of users to have 
different setups. The master profile controls group profiles and user profiles when a user is 
not a member of any group. All users are indirectly controlled by the master profile when 
option values are set to a restricted (R) status. 

From Setup > Master/Group..., select Tools > Create Group Profile. To add users to a 
group profile, select Tools > Update User Group. By default, the userid is found in the 
macro variable &SYSJOBID. This value is set in the option Userid in the master profile 
(option type System Administration). Change the value if your site uses another variable to 
keep the userid. If the value name starts with &, it is a macro variable; otherwise, it is an 
environment variable, which is set before the start of SAS 9.1.3. 
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Chapter 4: Post-Installation Setup for SAS/CONNECT Software 
TCP/IP is the access method supported for SAS 9.1.3 on Windows. For information about the access 
methods supported by other systems, refer to Communications Access Methods for SAS/CONNECT 
9.1 and SAS/SHARE 9.1. This document can be found at 
http://support.sas.com/documentation/onlinedoc/. 

Note: The APPC access method is no longer supported for the Windows operating system. 

Storing and Locating SAS/CONNECT Script Files 
Several sample script files are shipped with SAS/CONNECT software. SAS/CONNECT software uses 
these script files to establish a connection to a remote SAS session. 

The SASSCRIPT configuration option points to the location of the SAS/CONNECT script files. The 
SASSCRIPT option is used by SAS/ASSIST software and can be used by user-written SCL applications. 

Under Windows, the script files are installed into the !SASROOT\CONNECT\SASLINK directory by 
default. The following line is added to the SASV9.CFG file when SAS/CONNECT software is installed: 

-SASSCRIPT !SASROOT\CONNECT\SASLINK 

If you want to move the script files to another directory, you must edit the SASV9.CFG file and update 
the SASSCRIPT option with the new directory location. This option can also be specified from the 
Tools/Options/System/Communications/Networking and encryption selection in DMSEXP 
mode. 

TCP/IP 
TCP/IP is the access method supported for SAS 9.1.3 on Windows. SAS/CONNECT software supports 
Microsoft’s TCP/IP System Driver, which is provided with Windows. 

Configuring the SAS Windows Spawner Program 
The SAS Windows Spawner is stored in the !SASROOT directory and can be executed manually from 
the !SASROOT directory at any time. You can run the SAS Windows Spawner as a service by executing 
SPAWNER.EXE with the -install option. By default, the SAS Windows Spawner will be installed to 
run with security. For complete documentation on the Windows Spawner and the supported options, 
see Communications Access Methods for SAS/CONNECT 9.1 and SAS/SHARE 9.1.  

Note: If you are upgrading to SAS 9.1.3 and you run a spawner from a previous release as a 
service, you should stop and delete the existing spawner service. The SAS 9.1.3 CONNECT 
spawner can then be installed as a Windows service. 

By default, when the SAS Windows Spawner is installed as a Windows service, it runs under the 
LocalSystem userid that has all required User Rights for running the SAS Windows Spawner. If you 
do not install the SAS Windows Spawner as a Windows service (run it from your system prompt), the 
Windows userid used to start the SAS Windows Spawner must be the local Administrator of the 
machine and must have the following User Rights: 

• act as part of the operating system 
• bypass traverse checking (the default is everyone) 
• increase quotas 
• replace a process level token 
• log on locally (the default is everyone) 

The Windows userid specified at signon needs only the User Right “log on as a batch job.” 
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Chapter 5: Post-Installation Setup of Enterprise Miner Software 
These instructions cover post-installation steps for Enterprise Miner 4.3. For post-installation setup 
of Enterprise Miner 5.1 or Enterprise Miner 5.2, refer to the “Preparing Enterprise Miner for Use” 
chapter of the SAS Intelligence Platform: Administration Guide. 

Installing Enterprise Miner Server software  
If you licensed Enterprise Miner software and have completed the installation, you have installed the 
server components of Enterprise Miner software (referred to as the Enterprise Miner server).  

The SAS Enterprise Miner Server software is invoked from the Enterprise Miner Client via 
SAS/CONNECT. For more information about running Enterprise Miner, refer to Getting Started with 
the Enterprise Miner Software, Release 4.3, and Enterprise Miner Software: Changes and 
Enhancements, Release 4.3. 

Note:  Enterprise Miner requires that you configure SAS 9.1.3 Foundation for SAS/CONNECT. For 
this reason, please ensure that you have reviewed and completed the steps in the chapter 
“Post-Installation Setup for SAS/CONNECT Software” on page 10. 

Configuring Enterprise Miner Server Software 

Setup Default Data Library  
Create a data library on the server to which Enterprise Miner Client Software users have read/write 
access. This library should be a different folder than the SASROOT location, and ideally, on a different 
disk. To create the data library, make or designate a folder on an available disk and set appropriate 
permissions and ownership to allow remote users read and write access. 

Provide Information to Configure Enterprise Miner Client Software 
Provide the following information to users of Enterprise Miner Client Software to complete the 
configuration steps necessary for Enterprise Miner Client Software.  

• machine name and IP address of the server 
• how to invoke SAS 9.1.3 Foundation with SAS/CONNECT 
• how to access the default remote data library 

 Note: Do not specify a UNC pathname. 

Invoking Enterprise Miner 4.3 Client software 
After it is properly installed, Enterprise Miner Client software is invoked from SAS 9.1.3 under 
Windows. Once SAS 9.1.3 under Windows has been launched, you can invoke Enterprise Miner in the 
following ways:  

• Pull down the Solutions menu from the menu bar, then select the Analysis item, and then 
select Enterprise Miner.  

• Type miner in the SAS command bar. 

Configuring Enterprise Miner Client Software for Client-Server Projects 
To configure Enterprise Miner Client software for client-server projects, please refer to the section 
“Creating a Client-Server Project” in Getting Started with Enterprise Miner 4.3.  
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For more information about running Enterprise Miner, please refer to Getting Started with 
Enterprise Miner 4.3, and Enterprise Miner 4.3: Changes and Enhancements. 

SAS Standalone Formats for Enterprise Miner C*Score 
Enterprise Miner C*Score software requires Standalone formats that are found on the SAS Client-Side 
Components CD, which is included with your SAS Software distribution. When modeling data that 
contains SAS System formats, the data step score code uses those formats in the process of 
normalizing data for comparisons. As a result, the scoring code produced from such data step code 
will contain calls to these formats.  

The SAS System formats are supported in the Enterprise Miner C*Score generated ‘C’ code by use of 
the SAS Standalone Formats libraries. Follow these instructions to install the SAS Standalone 
Formats on the platform where you will be running your ‘C’ scoring code: 

1. Locate the SAS Client-Side Components CD that is included in your SAS Software 
package. Mount the CD according to the platform-specific instructions that are provided on 
the inside cover. 

2. In a browser, view the index.html page that is located in the root directory of your CD. 

3. From the index.html page, select the link SAS Standalone Formats for Enterprise 
Miner C*Score. 

4. Select the platform where you are running your ‘C’ scoring code; follow the associated 
instructions to install the SAS Standalone Formats on that platform. 
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Chapter 6: Post-Installation Setup for Enterprise Reporter 9.1 
Before you install Enterprise Reporter software, we recommend that you read the Administrator 
Guide on the CD, which contains an overview of the installation program.  

SAS System Viewer 
The SAS System Viewer is used to view and print files created by the SAS System. Enterprise Reporter 
uses this application to browse report data on your request. We recommend that you install the SAS 
System Viewer.  

Enterprise Reporter 9.1 runs on SAS 9.1.3 

Running Mixed Environments  
Users in a mixed environment running Enterprise Reporter 2.5, 2.6 and 9.1 can share data and 
reports on the network. However, previous releases (1.0, 1.5 and 2.0) of Enterprise Reporter cannot 
share reports with Enterprise Reporter 9.1. Opening a report created with Enterprise Reporter 2.0 (or 
earlier) with Enterprise Reporter 9.1 will convert the report. When converted, the report cannot be 
opened with Enterprise Reporter 2.0 again. 

Since SAS 9.1.3 does not support remote data from SAS 6.12 and earlier releases, we recommend that 
you convert the data to a newer SAS version. The infofolders also need updating when going from 
Enterprise Reporter 2.0 to Enterprise Reporter 9.1. You can either create new infofolders in 
Enterprise Reporter 9.1, or convert them from Enterprise Reporter 2.0 using Enterprise Reporter 2.5, 
Service Pack 3, and then use them directly in Enterprise Reporter 9.1. 

Enterprise Reporter Standard Edition 
The Standard Edition install is no longer available with Enterprise Reporter 9.1. Instead, the 
Administrator can create a Client Installation Image and distribute only the components needed for 
running Enterprise Reporter 9.1. For more information, please refer to the Administrator’s Guide. 

Users of Enterprise Reporter 9.1 

User Administration Environment 
Administrators can set up an environment for the users in which reports and data are shared. Users 
and groups must be set up, and it might be necessary to organize reports for groups of users. For more 
detailed information about setting up groups and users, please see Chapter 2, “User Administration” 
in the course note Enterprise Reporter Software: User and Data Administration Course Notes. 

It will also be necessary to create a file called ADMIN.INI, which points to the location of the user 
definitions: 

Administrator and Personal Users 
The previous releases of Enterprise Reporter contained a file, ADMIN.INI in the Enterprise Reporter 
folder ...\Business. The file was created during installation with customizations to fit your 
organization. The file is no longer created during installation, but you can reuse your ADMIN.INI or 
create a new one in the new location ...\reporter. 
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Client Users 
Client users run in partnership with the administrator version of ADMIN.INI. There are two types of 
Client installations: 

• a network installation, which does not have the complete directory ...\reporter installed on 
the PC. 

• an installation in which the user installs a Client Image created by the Administrator. In this 
situation, the user will have a complete ...\reporter directory. 

 For more information, please see the description under “Enterprise Reporter Standard Edition” 
above.  

Creating the ADMIN.INI file 
To create an ADMIN.INI file, write the text below in a text editor such as Notepad and save it to a file 
called ADMIN.INI (Make sure that the file has the extension .INI and not .TXT). You will have to 
change the default values after the equation marks in order to customize the file to your settings.  

Here is an example of an Enterprise Reporter initialization file, ADMIN.INI. 

 [License] 
Name=Your Name 
Company=Your Company 

 [Installation] 
Version=Enterprise Reporter, SAS System Edition 

 [Table Location] 
UserDefinitions=U:\Program Files\SAS\SAS 9.1\reporter\UserDef\ 
ServerDefinitions=U:\Program Files\SAS\SAS 9.1\reporter\ServerDef\ 

 [File Location] 
UserFiles= C:\Documents and Settings\USERNAME\My Documents\My SAS 
Files\Enterprise Reporter 

Note that UserFiles are pointing to the default location on WIN2000. Other operating systems 
have different default locations for user files. 

The settings in the ADMIN.INI file reflect the following in Enterprise Reporter 9.1:  

• [License]  

 

Name and Company are used in the About window in the Help menu to 
identify who has installed the software and where it is installed. 

• [Installation] 

 

Describes which version of Enterprise Reporter is installed. This 
information is used in the About window accessed from the Help 
menu. 

• [Table Location] 

 

Location of the tables used in user administration and location of server 
definitions used in data administration. 

• [File Location] 

 

Location of user files and folders for each user. The location must be on a 
local drive that all users can access, for example, c:\enterprise. This 
folder is automatically created the first time a user starts Enterprise 
Reporter.  

Upgrading a Previous Version to Enterprise Reporter 9.1 
With the previous release of Enterprise Reporter, release 2.6, the concept of Administrator 
installation and User installation changed. The standard for installation of SAS 9.1.3 Foundation is 
now being used for Enterprise Reporter as well.  
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Network and Local users of Enterprise Reporter 2.5 cannot be updated automatically to Enterprise 
Reporter 9.1. Instead, the administrator creates an installation image for users by running the SAS 
Administrator Wizard, and the users must install the created installation image of Enterprise 
Reporter 9.1 and the required SAS products. 

Running Directly on an Existing Release 2.5 User Administration 
Groups and users defined in Enterprise Reporter 2.5 can still be used in Enterprise Reporter 9.1. This 
requires that you have a file named ADMIN.INI pointing at your user definitions. For more details, 
please refer to the information about the ADMIN.INI file in “Creating the ADMIN.INI file” on  
page 14. 

Localized versions 
Enterprise Reporter 9.1 is released in an English version only.  

Starting Enterprise Reporter 9.1  
Enterprise Reporter is integrated with SAS 9.1.3. The software can be started using different methods: 

• Enterprise Reporter as an application outside SAS 9.1.3: 

Go to Start > Programs > SAS > Enterprise Reporter 9.1 > Enterprise Reporter 
9.1, SAS System Edition 

• Enterprise Reporter within SAS 9.1.3: 

Start SAS 9.1.3. Go to the Command line and type the command ER. 
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Chapter 7: Post-Installation Configuration for SAS Integration 
Technologies 

If you received SAS Integration Technologies software and have completed the installation of SAS 
9.1.3 Foundation, you have successfully installed the SAS server components of SAS Integration 
Technologies software. 

The SAS Client-Side Components CD that is included in your software order contains SAS Integration 
Technologies client components and documentation for SAS Integration Technologies software. 
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Chapter 8: Installing SAS IT Resource Management 
Please note that SAS IT Resource Management now ships with both the 2.7 and 3.1.1 versions for 
Windows.  

• If you are installing SAS IT Resource Management 2.7, you should follow the procedures in 
the “Configuring SAS IT Resource Management 2.7” section below to complete your 
installation.  

• If you are installing SAS IT Resource Management 3.1.1, you should follow the procedures in 
the “Configuring SAS IT Resource Management 3.1.1” section on page 21 to complete your 
installation. 

SAS IT Resource Management Functionality 
For new and updated technical papers, newsletters, and user documentation (including the Macro 
Reference and User's Guide), please visit the following SAS Web site: 

http://support.sas.com/itrm. 

SAS IT Resource Management is a data management and presentation software package used to 
access, manage, integrate, aggregate, and analyze large quantities of performance data about many IT 
resources, such as these: 

• hardware 
• operating system software 
• networks,  
• Web servers 
• databases 
• applications 

This IT performance data is generated by the logging mechanisms that are inherent to IT resources or 
that are created by the Enterprise Systems Management tools that are employed to manage the IT 
infrastructure.  

SAS IT Resource Management 2.7 has both client and server components. The server software is 
required to process, reduce, and/or update the data in a performance data warehouse (PDB) located 
on your system. The client software is required only if you want to access a performance data 
warehouse on a remote server system from a client PC platform.  

SAS IT Resource Management 3.1.1 has server components and uses IT Resource Management 
enhanced SAS 9 client components as the user interface to the solution.  

SAS IT Resource Management Server runs on Microsoft Windows NT Server, z/OS, and selected 
UNIX operating systems.  

SAS IT Resource Management Client runs on Microsoft Windows platforms supported by SAS 9.1.3. 

For the latest documentation information about SAS IT Resource Management, please look at the 
“SAS IT Resource Management Documentation” page, http://support.sas.com/itrm. 

Note:  SAS IT Resource Management was formerly known as IT Service Vision. Some 
documentation and references may still use the former name.  



Post-Installation Guide for SAS 9.1.3 Foundation for Microsoft Windows 

18 

Installing SAS IT Resource Management 2.7 

Migration Considerations 
If you have modified your SITELIB library, you will need to save a copy of it so that you can merge it 
into the new SITELIB library. Please see the instructions in “Site Library Considerations” on page 19. 

If you have an existing SAS IT Resource Management installation and want to migrate from SAS 
Version 8 to SAS 9, refer to the conversion information in the directory 
!SASROOT\cpe\itsvdocs\convert89.htm and at www.sas.com/itsvconv. 

If you have an earlier release of SAS IT Resource Management installed, we recommend that you 
uninstall it prior to installing SAS IT Resource Management 2.7. If you choose not to follow this 
recommendation, SAS IT Resource Management 2.7 will be installed in the same location, and your 
earlier release of SAS IT Resource Management will be overwritten. Only SAS IT Resource 
Management 2.7 will be available.  

To remove the earlier release of SAS IT Resource Management from a Windows platform, follow the 
path: Start > Settings > Control Panel > Add/Remove Programs. 

If you uninstall an earlier release of SAS IT Resource Management after you install SAS IT Resource 
Management 2.7, SAS IT Resource Management 2.7 will not be usable. SAS IT Resource Management 
2.7 will need to be reinstalled. 

Installation Customizations 
SAS IT Resource Management Solution will be installed into the !SASROOT\cpe folder. If you want 
to customize your SAS IT Resource Management installation, or see any additional SAS System 
components present on your media, select Customize from the Solutions window.  

Starting SAS IT Resource Management  
To start SAS IT Resource Management from your Windows desktop, select Start > Programs > 
SAS IT Resource Management > SAS IT Resource Management 2.7. 

To start SAS IT Resource Management from within SAS, issue the itrm command. You can issue the 
itrm command in the SAS toolbar command area or after the Command > prompt, which is 
obtained by clicking on Globals > Options > Command Line. You can also start SAS IT Resource 
Management 2.7 from within SAS by submitting this statement by using the Program Editor: 

%CPSTART(); 

SAS IT Resource Management Documentation  
For the latest documentation information about SAS IT Resource Management, please visit the “SAS 
IT Resource Management Documentation” page, http://support.sas.com/itrm. 

For more information on running and configuring SAS IT Resource Management, please see Getting 
Started with SAS IT Resource Management 2. A link to this guide can be found on the Web page 
listed above. 

Online documentation is also available from within SAS and SAS IT Resource Management. From 
SAS, select Help > Getting Started with SAS Software > Help on SAS software Products > 
SAS IT Resource Management.  

From the SAS IT Resource Management user interface, select OnlineHelp > SAS IT Resource 
Management Help > Help on SAS software Products > SAS IT Resource Management.  
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Select OnlineHelp > Other ITRM Documentation for the following documents: 

• Collector Updates 
• Link to SAS IT Resource Management on the Web 
• Server Setup Guide  
• QuickStart Examples  
• Migration - Also directly available with a Web browser from 

!SASROOT\cpe\itsvdocs\convert89.htm and at www.sas.com/itsvconv  

Site Library Considerations 

First Time Installations 
If you are installing SAS IT Resource Management for the first time, you may want, at some future 
date, to create a separate SITELIB directory to store site-wide options or customizations, such as 
your site’s preferred graphics device. The supplied version of this directory containing default values 
will have been created in !SASROOT\cpe\sitelib during the default production installation of SAS 
IT Resource Management.  

Wherever you choose to locate SITELIB, you must have write access to it, and all other SAS IT 
Resource Management software users must have read access. If you choose to re-locate SITELIB, 
follow the instructions in “Modifying the Pointer to the Default SITELIB Library” on page 20. 

Upgrading existing installations 
If you have previously installed SAS IT Resource Management on this system, it is strongly 
recommended that you consider the location of your existing production SITELIB before you install 
this release of SAS IT Resource Management. Without planning, you risk overlaying and losing 
existing PDB and site options.  

When you installed SAS IT Resource Management previously, a directory containing default values 
was created in !SASROOT\cpe\sitelib. Since then, you may have created another SITELIB 
library and re-programmed SAS IT Resource Management to use this new location as its default 
SITELIB. If you are not sure if this happened, you can find out by starting SAS and your existing SAS 
IT Resource Management software interactively, and then issuing the LIBNAME command from the 
command line in the toolbar. Note the location of the SITELIB library.  

In either case, you should close your LIBNAME window, the SAS IT Resource Management 
application, and the SAS session, and make a backup of that whole directory now. This will ensure 
that you have a method of restoring the directory’s contents if a problem occurs after the update. 

If you have previously installed SAS IT Resource Management on this system, you now need to 
consider the maintenance of the SITELIB library. In the SASMISC directory just installed, locate a 
member called CPSITEUP. This code will merge your old, production SITELIB library with your 
newly installed version. Please read the following sections for details on site libraries and how to run 
the code. 

Maintaining SITELIB with Previous SAS IT Resource Management Installations 
Note: The following section is relevant when SAS IT Resource Management was previously 

installed. 

When a new version or release of SAS IT Resource Management is installed, a new SITELIB library is 
created. This ensures that you are able to access any SITELIB updates that may have been made in 
the product.  

However, since you have the opportunity to update the menu and other SITELIB datasets, you will 
probably want to save your modifications and avoid re-engineering them in the new library from 
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scratch. To preserve your modifications, we have supplied code that will merge your existing 
production SITELIB datasets and catalogs in with the new versions. This code is contained in the 
!SASROOT\cpe\sasmisc directory. 

If you have an existing production SITELIB library that contains site-wide options or datasets that 
you want to make available to the new release of SAS IT Resource Management, locate the CPSITEUP 
member and review its contents. 

The CPSITEUP code refers to three SITELIB libraries: 

1. The newly installed SITELIB, referred to as NEWSITE, 

2. The current, production/default SITELIB (whether it is the previously installed SITELIB or a 
subsequently relocated version), referred to as OLDSITE, and 

3. PRODSITE, which is used in referring to your chosen location for the production SITELIB for the 
newly installed release of SAS IT Resource Management. 

So, before running CPSITEUP, ensure that the following updates have been made: 

• NEWSITE points to your newly installed SITELIB. 
• OLDSITE points to your current production/default SITELIB. 
• PRODSITE points to a directory or library from which you want to run SAS IT Resource 

Management 2.7. This could be the same location as OLDSITE or NEWSITE, in which case 
those libraries will be overwritten, or it could be somewhere new. 

Run the CPSITEUP code, following the instructions at the top of the code. 

If you have decided to use a SITELIB library with a location other than the newly installed SITELIB 
for 2.7, CPSITEUP will also update the pointer held in PGMLIB so that your chosen SITELIB becomes 
the new default SITELIB. You will not need to perform the task described below in “Modifying the 
Pointer to the Default SITELIB Library.” 

Other tools that are available for modifying site-wide options are the macros %CPPDBOPT and 
%CPHDAY, both of which are documented in the SAS IT Resource Management Macro Reference. 

Modifying the Pointer to the Default SITELIB Library 
A SITELIB directory and its files must be write-able by the SAS IT Resource Management 
administrator and readable by all other SAS IT Resource Management software users.  

When SAS IT Resource Management is started using the %CPSTART macro, you have the option of 
specifying the SITELIB= parameter. This is not required and is usually not specified. If it is specified, 
the SITELIB= value is used as the SITELIB library for only that invocation. Otherwise, the default 
SITELIB library will be used.  

This default value is stored in the PGMLIB library and is set at installation to be the name of the newly 
installed SITELIB library. If you need to change that default, submit the following program: 

Note:  Update-access to the PGMLIB library and its components is required. 

libname pgmlib '!sasroot\cpe\pgmlib\'; 
data pgmlib.cpsite; 
cpsite="name.of.new-or-updated.sitelib"; 
run; 

Installing NTSMF (Windows NT Server only)  
New SAS IT Resource Management sites receive the product package NTSMF by Demand 
Technology. NTSMF software can be used to collect performance metrics from up to 50 PC platforms.  
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If you want to collect resource utilization metrics from your NT servers using NTSMF software, you 
will need to install it on every NT server that you want to monitor. 

Follow the instructions for installing NTSMF in the NTSMF materials. If you have any support 
questions regarding NTSMF, please contact Demand Technologies directly. Contact information for 
Demand Technologies can be found in the NTSMF materials. 

There are two NTSMF DCS files for NT Server and NT Exchange that match the selection of 
QuickStart metrics in SAS IT Resource Management. The files are named ntserv and ntexng. They 
are located in the !SASROOT\cpe\sasmisc directory of your SAS IT Resource Management 
installation software. Import the files into Demand Technology’s Performance SeNTry for use with 
the QuickStart Wizard. 

Configuring SAS IT Resource Management 3.1.1 
IMPORTANT:  With the availability of the 311IS04 hotfix, it is important to read that hotfix’s 

installation instructions in combination with these instructions. The method by 
which SAS IT Resource Management metadata is deployed to the SAS Metadata 
Server has changed.  

 In summary, if you have an empty ITMS repository and have not deployed any 
metadata, you will be instructed to execute the deployITRM_win.bat script with 
DACTION=initialize. If you happen to have deployed at least some metadata or 
you have an existing ITMS repository, you will be instructed to execute the same 
script with DACTION=hotfix to migrate it. 

SAS IT Resource Management 2.7 and SAS IT Resource Management 3.1.1 are both current releases 
of this solution. The difference in the software releases is that SAS IT Resource Management 2.7 runs 
on SAS 9.1.3, and SAS IT Resource Management 3.1.1 runs on and fully leverages the SAS 9.1.3 
architecture to create an IT data mart. 

In order for the newly installed IT Resource Management 3.1.1 software to function properly there are 
manual, post-install configuration steps that must be completed. This section addresses required 
modifications for server-, client- and mid-tier installations. If you are planning on using SAS IT 
Resource Management 2.7, you should not perform these modifications. 

Integration with other SAS IT Management Solutions 
SAS IT Resource Management 3.1.1 does not integrate with SAS IT Service Level Management or SAS 
IT Charge Management. SAS IT Resource Management 2.7 remains the prerequisite release for those 
solutions. 

SAS IT Resource Management 2.7 is the prerequisite release for SAS IT Service Level Management 
and SAS IT Charge Management. Future releases of IT Service Level Management and SAS IT Charge 
Management will include enhancements necessary for compatibility with SAS IT Resource 
Management 3.1.1. 

SAS IT Resource Management Documentation  
For the latest documentation information about SAS IT Resource Management, please see the SAS IT 
Resource Management Documentation page, http://support.sas.com/itrm, document 
Introduction to SAS IT Resource Management 3.1.1 that introduces the concepts and facilities of 
release 3.1.1. 

Note:  The following modifications are being made to existing files in your installation. We 
recommend that you make a backup copy of any file referenced prior to editing its content. 
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Server Tier Modifications 

Migration Considerations 
To migrate your SAS IT Resource Management 2.7 PDB to a SAS IT Resource Management 3.1.1 IT 
data mart, follow the instructions provided in SAS IT Resource Management 3.1.1: Migration 
Documentation available from http://support.sas.com/itrm. If you have not already done so, 
it is recommended that you apply the latest hot fix available for SAS IT Resource Management 2.7. 

SAS Configuration File 
The following changes must be made to the SAS configuration file (typically located in 
!SASROOT\nls\<language>). 

JREOPTIONS 

1. At the beginning of the list of options (immediately after the opening parenthesis), add the 
following:  

-Xmx256m -Xms256m -DentityExpansionLimit=10000000 

(Note that the preceding number is 10 million - 1 followed by 7 zeros.) 

2. Insert the following at the start of the sas.app.class.dirs directive: 

"!SASROOT\itmsmvadata\sasmisc;" 

3. To the end, add the following directive before the closing parenthesis: 

-DSAS.JAVAOBJ.EXPERIMENTAL=NO 

4. When you have completed the updates to your JREOPTIONS option, it should appear similar 
to this: 

-JREOPTIONS=(-Xmx256m -Xms256m -DentityExpansionLimit=10000000 -
Dsas.jre.home=C:\PROGRA~1\SAS\SHARED~1\JRE\1499C1~1.2_0 -
Djava.security.policy=!SASROOT\core\sasmisc\sas.policy -
Dsas.app.class.dirs=!SASROOT\itmsmvadata\sasmisc;!SASROOT\core\sa
smisc;C:\PROGRA~1\SAS\SHARED~1\applets\9.1 -Dsas.jre=private -
Dsas.ext.config=!SASROOT\core\sasmisc\sas.java.ext.config -
DPFS_TEMPLATE=!SASROOT\core\sasmisc\qrpfstpt.xml -
Djava.class.path=!SASROOT\core\sasmisc\sas.launcher.jar -
Djava.system.class.loader=com.sas.app.AppClassLoader -
DSAS.JAVAOBJ.EXPERIMENTAL=NO) 

Format catalog search order 

To the end of the config file, and on a line of its own, add the following option: 

-FMTSEARCH=(ADMIN.ITMS SASHELP.ITMS_FORMATS WORK LIBRARY) 

MXG environment variables 

If you have Merrill’s Expanded Guide to CPE (MXG) installed, you must also complete the following: 

1. Add the following two lines to your configuration file after the FMTSEARCH option: 

-SET MXGSRC '<custom> <sourclib>' 

-SET MXGFMT '<formatlib>' 

Where <custom> is the path to your MXG custom source library, sometimes referred to as 
MXG.USERID.SOURCLIB, without quotes; <sourclib> is the path to your MXG source 
library, sometimes referred to as MXG.MXG.SOURCLIB, without quotes; and <formatlib> 

http://support.sas.com/itrm�
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is the path to your MXG format library, sometimes referred to as MXG.MXG.FORMATS, 
without quotes. For example: 

-SET MXGSRC 'C:\DOCUME~1\myid\MYDOCU~1\MXG\CUSTOM\SOURCLIB <SAS-
Install-Directory>\MXG\SOURCLIB' 

-SET MXGFMT '<SAS-Install-Directory>\MXG\FORMATS' 

Note:  Path names with embedded blanks are not supported. If blanks cannot be removed, 
the notation must follow 8.3 syntax. 

2. You must also complete the MXG modification to the autoexec.sas file used by your 
Workspace Server. This modification is specified in the next section. 

SAS Autoexec File 
If your installation requires interaction with MXG, then you must also modify the autoexec.sas file 
used by your Workspace Server. This file is called appserver_autoexec.sas and is typically 
located in: 

<Install Drive>:\SAS\<project-directory>\Lev1\SASMain 

Add the following line to the end of the file: 

%RMMXGINI; 

Note: You should have also completed the associated MXG modification to the SAS configuration 
file specified in the previous section. 

Update Default Authorizations 
During job execution, SAS IT Resource Management 3.1.1 creates information maps. In order to 
successfully accomplish this task, you should modify the Default Access Template for the SAS 
Metadata Repository (SMR) user(s) or group(s) that will be creating and submitting jobs for SAS IT 
Resource Management 3.1.1. The following steps describe how to make this change. 

Create IT Resource Management User(s) or Group(s) 

Note:  User(s) or group(s) should be created only in the Foundation repository. Do not create 
user(s) or group(s) in the ITMS repository. 

1. Launch the SAS Management Console and ensure that you are connected to the Foundation 
repository of your metadata server. 

2. The instructions in this step refer to an “ITRM Users” group. This is a group defined in the 
Foundation SMR that simplifies the management of authorizations for many users and/or 
groups. Modifications to the Default Authorizations are applied to all of the users and groups 
that are members of “ITRM Users.” If you would prefer to have your SMR Users organized in 
a group like this so that permissions can be managed and modified for a single entity, you can 
create a group as follows: 

A. Select User Manager. 

B. Right-click and select New→Group from the pop-up dialog. 

C. On the General tab, supply a unique name such as ITRM Users. 

D. On the Members tab, select the users who will be part of this group, and use the 
right arrow widget between the two panes to add them to the group. 

E. Click OK to save the group. 
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Update Default Authorizations for User(s) and Group(s) 

Note:  Ensure that the following steps have been performed in both the Foundation and the ITMS 
repositories. 

1. If the SAS Management Console is not still available from the previous step, start it and 
ensure that you are connected to the Foundation repository of your metadata server. 

2. Select the Authorization Manager and expand the Access Control Templates item. 

3. Select Default ACT. 

4. Right-click and select Properties from the resulting pop-up dialog. 

5. Select the Users and Permissions tab. 

6. If the list of available names does not include the user or group whose Default ACT is to be 
modified, follow these steps to add it: 

A. Click Add… 

B. For each user or group that you want to add to the Selected Identities, select the item 
in the list of Available Identities and then use the right arrow between the panes to 
add the item to the Selected Identities. It is here that you should select the “ITRM 
Users” group if it was created in the previous section. 

C. Click OK. 

7. Set the following permissions for each Identity that you want to update (and also ensure that 
none have Deny selected on the Authorization tab): ReadMetadata, WriteMetadata, Read, 
and Delete. 

8. After all necessary items have been modified, click OK. 

9. Using the SAS Management Console, connect to the ITMS repository of your metadata server 
and repeat steps 2-8. 

Server Tier Hot Fixes 
To function properly, SAS IT Resource Management requires several hot fixes and installation 
actions. For the complete list, refer to SAS Note 30753: Fixes to apply to SAS® IT Resource 
Management release 3.1.1, which can be found at http://support.sas.com/kb/30/753.html. 

Client-Tier Modifications 

Tuning the SAS Data Integration Studio Invocation 
In order for the SAS IT Resource Management 3.1.1 client software to function properly, you need to 
modify the options that are passed to the Java Virtual Machine (JVM) when SAS Data Integration 
Studio is started. 

The file to modify is <SAS Home Directory>\SASETLStudio\9.1\etlstudio.ini. Before you 
continue, please create a backup copy of this file. Edit the original file by adding the following 
options to the beginning of the list immediately following CommandLineArgs= : 

-Xmx1024m -Xms128m -Xss1m 

After you complete the updates, your etlstudio.ini CommandLineArgs= line should appear 
similar to the following: 

CommandLineArgs=-Xmx1024m -Xms128m -Xss1m  
-Djava.system.class.loader=com.sas.app.AppClassLoader  
-Djava.security.auth.login.config=security/login.config  
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-Djava.security.policy=security/auth.policy  
-Dsas.app.class.dirs="C:\Program Files\SAS\SASETLStudio\9.1"  
-Dsas.app.class.path=sas.dbuilder.app.jar;.  
-Dsas.ext.config=sas.java.ext.config -cp sas.launcher.jar 
com.sas.wadmin.application.TheAppWA 

Client-Tier Hot Fixes 
You should apply all the SAS Data Integration Studio, SAS Enterprise Guide, and SAS Information 
Map Studio hot fixes currently available from SAS Technical Support. The hot fixes and the 
instructions for applying them can be found at the Technical Support Hot Fixes Web page, located at 
http://ftp.sas.com/techsup/download/hotfix/op_home.html.    

Mid-Tier Modifications 

Configure SAS Web Report Studio for use with SAS IT Resource Management 3.1.1 
A unique instance of SAS Web Report Studio configured for use with the ITMS dependent repository 
is required for use with SAS IT Resource Management 3.1.1. The configuration changes that are 
required for SAS IT Resource Management should be made after SAS Web Report Studio has been 
installed and a default configuration has been completed. If you have not already installed and 
configured SAS Web Report Studio, please stop and return to this document after completing that 
task. In addition, before you continue, please ensure that your SAS Metadata Server is running. 

Create a new subdirectory off the top-level in WebDAV 
1. Access the xythosadmin GUI 

(http://<nodename.domain.com>:<port>/xythosadmin) using the Administrator 
userid and password. 

2. Select File System then click Find Top-Level Directory. 
3. Select sasdav and then click Add New Sub-Directory. 
4. For the name, specify ITMS and change the Quota to Unlimited. 
5. Click Create Directory. You should now see ITMS as a subdirectory of sasdav. 
6. Click on the Permissions icon to set user permissions. 
7. Click Search for Users and Groups, type administrator in the Contains field, and select 

OK. 
8. Select SAS Web Administrator and then OK. 
9. For the row corresponding to SAS Web Administrator, set all permissions to Yes. 
10. Save your changes. 

The following three steps require interaction with the SAS Metadata Server. To facilitate this, launch 
the SAS Management Console on your Mid-Tier Server. 

Add /sasdav/ITMS as an available base path 
1. Confirm that the Foundation repository is the current, active repository. 
2. Expand Server Manager. 
3. Select HTTP DAV Server. 
4. Right-click and then select Properties from the resulting popup dialog. 
5. Select the Options tab and then click the New… button. Supply /sasdav/ITMS as the Base 

Path. Be sure to select the Supports WebDAV checkbox. Click OK. 
6. Click OK. 

http://ftp.sas.com/techsup/download/hotfix/op_home.html�
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Add the ITMS Repository to Information Services for SAS Web Report Studio 
In order for SAS Web Report Studio to find content in a repository other than Foundation, you must 
add the ITMS repository, which is a dependent repository, to the Platform Information Service within 
Query and Reporting services. 

1. On the mid-tier server, launch the SAS Management Console and connect to the Foundation 
repository on the Data Server as the administrative unrestricted user (sasadm, for example). 

2. Expand the Foundation Services Manager. 
3. Expand Query and Reporting. 
4. Expand BIP Core Services. 
5. Select Platform Information Service to highlight it and then select File > Properties 

from the pull down menu. 
6. Select the Service Configuration tab. 
7. Select the Edit Configuration... button. 
8. Select the Repositories tab. 
9. Select New... to add the ITMS repository. 
10. Supply the following information: 

• Protocol: omi 
• Name: ITMS 
• Description: <optional, enter your description here> 
• Host: Fully qualified nodename hosting the SAS Metadata Server containing the ITMS 

repository (for example, nodename.domain.company.com) 
• Port: The port the SAS Metadata Server is listening on (default: 8561) 
• Domain: The authentication domain for the SAS Metadata Server connection (default: 

DefaultAuth) 
• Base: ITMS 
• Proxy: No value needed by default 
• Auto-Connect checkbox: Selected 
• Secure checkbox: By default not selected, select only if encryption is supported and the 

connection to the repository will be made using a secure protocol. 
Select OK. 

11. Select OK twice to save changes. 

Add the ITMS Repository to Information Services for the SAS Information Delivery 
Portal  
In order for the SAS Information Delivery Portal to find content in a repository other than 
Foundation, you must add the ITMS repository, which is a dependent repository, to the BIP 
Information Service. This must be done for both the BIP Local Service OMR service in the ID Portal 
Local Services item and the BIP Remote Services OMR service in the Remote Services item. 

1. On the mid-tier server, launch the SAS Management Console and connect to the Foundation 
repository on the data server as the administrative unrestricted user (sasadm, for example). 

2. Expand the Foundation Services Manager. 

3. Expand ID Portal Local Services. 

4. Expand BIP Local Services OMR. 

5. Select BIP Information Service to highlight it and then select File→Properties from the 
pull down menu. 

6. Select the Service Configuration tab. 

7. Select the Edit Configuration button. 
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8. Select the Repositories tab. 

9. Select New to add the ITMS repository. 

10. Supply the following information: 

• Protocol: omi 
• Name: ITMS 
• Description: <optional, enter your description here> 
• Host: Fully qualified nodename hosting the SAS Metadata Server containing the ITMS 

repository (for example, nodename.domain.company.com) 
• Port: The port the SAS Metadata Server is listening on (default: 8561) 
• Domain: The authentication domain for the SAS Metadata Server connection (default: 

DefaultAuth) 
• Base: ITMS 
• Proxy: No value needed by default 
• Auto-Connect checkbox: Selected 
• Secure checkbox: By default not selected, select only if encryption is supported and the 

connection to the repository will be made using a secure protocol. 

Select OK. 

11. Select OK twice to save changes. 

Repeat steps 3 through 11 above, expanding Remote Services for step 3 and BIP Remote Services 
OMR for step 4. 

Update the Repository Root Folder Properties 
The repository root folder, as specified during the installation of SAS Web Report Studio (and output 
to the file < SAS Web Report Studio Install Folder>\wrs.config), must be configured in 
order for SAS Web Report Studio to function properly. The default repository root folder is BIP 
Tree. For SAS IT Resource Management 3.1.1 this should be changed so that ITRMSoftwareTree is 
configured as the root instead. To make this change, perform the following steps: 

1. On the mid-tier server, launch the SAS Management Console and connect to the ITMS 
repository. Note that you can connect to Foundation and then use the Repository: 
dropdown to switch to the ITMS repository. You should log in as the administrative super 
user (sasadm, for example). 

2. Expand the BI Manager. 
3. Select the ITRMSoftwareTree folder to highlight it and then select File > Properties 

from the pull-down menu. 
4. Select the Content Mapping tab. 

There should already be a WebDAV content server defined with a format of 
http://<dataserver.domain:port>, for example, 
http://dataserver.sas.com:80 ). You can use this for SAS Web Report Studio content 
as well. Just select it from the Server drop-down. If you need to add additional content 
servers, use Server Manager in SAS Management Console while connected to the Foundation 
repository. 

5. Select the Content Base Path. 
Base paths specify the URLs that are available on the content server. Earlier in these 
instructions you defined a new subdirectory off the top-level in WebDAV (/sasdav/ITMS). 
You should now use that as the base path. You can use this base path by selecting it from the 
Base Path drop-down.  

If you deploy more than one instance of SAS Web Report Studio (for example, one 
deployment for each dependent repository), you should define a different base path for each 
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instance so the data for each deployment is maintained separately. To add additional base 
paths for a server, use Server Manager in the SAS Management Console. After they have been 
added, they will be available for selection in the Base Path drop-down. 

6. If you are using Xythos to manage your WebDAV server, you will need to specify the SAS Web 
Administrator userid and password. This information can be found in your Pre-installation 
Checklists. 

7. Select OK to save changes.  
You will receive a dialog box that states, "Content Server, Base Path, and User ID must be 
specified for the root folder to be functional. Continue Anyway?" Select Yes. 

Update Your Web Application Server Policy File 
If applicable, ensure that the appropriate sas.wrs.*.policy file has been included in your Web 
application server's policy file. 

Edit the WebReportStudioProperties.xml File 
The WebReportStudioProperties.xml file can be located as follows, depending on the host on 
which your mid-tier resides.  

UNIX 

The WebReportStudioProperties.xml file that must be modified in this step can be found in the 
SASWebReportStudio/WEB-INF directory in your Web application server's deployment directory. 
For example, if you are using Jakarta Tomcat as your Web application server and have installed it to 
<install-location>/jakarta-tomcat-4.1.18 then you should find the file in <install-
location>/jakarta-tomcat-4.1.18/webapps/SASWebReportStudio/WEB-INF. 

Windows 

The WebReportStudioProperties.xml file that must be modified in this step can be found in the 
SASWebReportStudio\WEB-INF directory in your Web application server's deployment directory. 
For example, if you are using Jakarta Tomcat as your Web application server and have installed it to 
<install-drive>/Tomcat4.1 then you should find the file in <install-
drive>\Tomcat4.1\webapps\SASWebReportStudio\WEB-INF. 

Note:   Element content that is underlined should be modified to the value shown below in bold. 

Change 

   <repository>Foundation</repository> 

         to 

    <repository>ITMS</repository> 

Change the content of the citation.model.repository element so that it appears as follows: 

  <citation.model.repository> 
    <path> 
      <!-- default value: /                                        --> 
      <root>/</root> 
      <!-- Note, these are appended to <root>                      --> 
      <!-- default value: ReportStudio                             --> 
      <citationweb>ITReportStudio</citationweb> 
      <!-- default value: ReportStudio/BannerImages                --> 
      <bannerImages>ITReportStudio/BannerImages</bannerImages> 
      <!-- Info maps are searched from this location down          --> 
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      <!-- default value: ReportStudio/Maps                        --> 
      <maps>ITDataMartTree</maps> 
      <!-- the "root" for shared files (reports subdir goes here). --> 
      <!-- default value: ReportStudio/Shared                      --> 
      <shared>ITReportStudio/Shared</shared> 
      <!-- the "root" for a user's files;                          --> 
      <!-- username as a subdirectory is created here,             --> 
      <!-- (reports subdir goes under that).                       --> 
      <!-- default value: ReportStudio/Users                       --> 
      <users>ITReportStudio/Users</users> 
      <!-- the subdir created in the shared/user area for reports  --> 
      <subdirReports>Reports</subdirReports> 
      <!-- the subdir created in the shared/user area for queries  --> 
      <subdirQueries>Queries</subdirQueries> 
    </path> 
    <!-- Repositories often have more than 1 "root folder", --> 
    <!-- this parameter indicates which should be used if   --> 
    <!-- there are more than one.                           --> 
    <rootFolderName> ITRMSoftwareTree </rootFolderName> 
  </citation.model.repository> 

Save these configuration changes. 

Note:   If SAS Web Report Studio is reconfigured and redeployed, you must repeat the steps in this 
section to reapply the changes to the WebReportStudioProperties.xml. More 
information about the administrative files for SAS Web Report Studio can be found in the 
SAS 9.1.3 Intelligence Platform Web Application Administration Guide. 

Restart the SAS Services Application and Your Web Application Server 
Your configuration changes to the mid-tier are now complete. In order for these modifications to 
become effective, you should restart the SAS Services Application and your Web application server. To 
do this correctly, stop the Web application server first and then the SAS Services Application. When 
ready to restart you should start the SAS Services Application first, followed by the Web application 
server. 

Mid-Tier Hot Fixes 
You should apply the SAS Web Report Studio hot fix currently available from SAS Technical Support. 
The hot fix and the instructions for applying it can be found at the Technical Support Hot Fixes Web 
page, located at http://ftp.sas.com/techsup/download/hotfix/op_home.html. 

Updating SAS IT Resource Management 3.1 to 3.1.1 
The SAS IT Resource Management 3.1.1 Update Installation process is designed to update an existing 
installation of SAS IT Resource Management 3.1 to SAS IT Resource Management 3.1.1. 

This process requires that a SAS IT Resource Management 3.1 installation is present. 

All currently active SAS sessions, servers, processes, daemons, and spawners must be terminated 
before proceeding. You should back up all directories that may be updated. To accomplish this you 
may use an operating system directory copy or any number of archive copy utilities (such as WinZip, 
tar, jar, etc.). By backing up your existing software, configuration, and metadata associated with your 
IT data marts, you will be able to return to your existing installed state should you need to rerun this 
process. 
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The following list is the recommended minimum set of folders to back up: 

Server Tier 

• <SAS-Home-Directory>\SAS 9.1 
• <SAS-Home-Directory>\SASITMSCoreComponents 
• <SAS-Configuration-Root-Directory>\<SAS-Configuration-Directory> 

Client Tier 

• <SAS-Home-Directory>\SASETLStudio 

For example, assuming default installation and configuration locations, these paths would be: 

Server Tier 

• C:\Program Files\SAS\SAS 9.1 
• C:\Program Files\SAS\SASITMSCoreComponents 
• C:\SAS\ITRM 

Client Tier 

• C:\Program Files\SAS\SASETLStudio 

Because the installation of new software will overwrite existing configuration files and there may be 
new hot fixes to apply, there will be manual post-installation configuration steps that must be 
performed. 

A full Java Development Kit (JDK) is required by the scripts that deploy and configure the SAS IT 
Management Solutions Core Components Data Tier software on the Server Tier. For Windows 
platforms, the recommended version is 1.4.2_05. Please ensure that this JDK is installed prior to 
beginning the Deploy and Configure section. 

Installing the Software 
Although this is not a planned install, the “tier” terminology is used in determining the target location 
for the updated software. 

Server Tier Update 
This step updates the software that has been installed and configured on your server tier. The 
components affected by this are the SAS 9.1 Foundation and SAS IT Management Solutions Core 
Components Data Tier. 

Complete the following steps: 

1. Launch the SAS Software Navigator. 

2. For the type of deployment to perform, choose Software Index. 

3. Supply the SAS Installation Data that you received with your SAS IT Resource Management 
3.1.1 package. 

4. Verify the SAS Installation Data that you received with your SAS IT Resource Management 
3.1.1 package. 

5. Expand the CD Index folder and select the appropriate folder to install (update) the following 
components: 

A. Install SAS 9.1 Foundation. 

On Windows systems, there is a back-up made of the sasv9.cfg configuration file. 
You may want to make your own copy so that you can use it as a guide after you 
complete the SAS 9.1 Foundation installation process. This installation will overwrite 
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the configuration file, so you will need to reapply the server tier modifications that 
apply to the SAS configuration file after completing the following instructions. 

i. Expand the folder for SAS Setup Disk. 

ii. Select the SAS Foundation item. 

iii. In the right pane, select step 4 in the list of End User Steps. 

iv. Step through the dialog windows, accepting the defaults (unless otherwise 
necessary). When presented with the dialog that indicates “Existing SAS 
Installation Found,” choose Add Components to SAS. 

v. Continue with the installation of this component to the end. 

B. Install SAS IT Management Solutions Core Components Data Tier. 

i. Expand the second folder for SAS IT Resource Management and SAS 
IT Management Solutions. 

ii. Select the SAS IT Management Solutions Core Components Data 
Tier item. 

iii. In the right pane, scroll down and select the Install link for your platform. 

iv. Proceed with the installation. If prompted, respond Yes or Yes to All to 
overwrite existing content. 

v. Select Finish on the last dialog window. 

C. Reapply Configuration Updates to the Server Tier. 

The preceding installation will have overwritten the configuration file. You will need 
to reapply the server tier modifications that apply to the SAS configuration file, as 
described in the “Server Tier Modifications” section on page 22 of this chapter. 

Client Tier Update 
This step updates the software that has been installed and configured on your client tier. The 
components affected by this are the SAS IT Management Solutions Core Components Client and the 
SAS IT Resource Management Client. This update should be performed only on Windows platforms 
that contain the original 3.1 release of these client components. 

Complete the following steps: 

1. Launch the SAS Software Navigator. 

2. For the type of deployment to perform, choose Software Index. 

3. Supply the SAS Installation Data that you received with your SAS IT Resource Management 
3.1.1 package. 

4. Verify the SAS Installation Data that you received with your SAS IT Resource Management 
3.1.1 package. 

5. Expand the CD Index folder. 

6. Expand the first folder for SAS IT Resource Management and SAS IT Management 
Solutions and then select the appropriate link to install (update) the following components: 

A. Install SAS IT Management Solutions Core Components Client. 

i. Select the SAS IT Management Solutions Core Components Client 
item. 

ii. In the right pane, scroll down and select the Install link. 
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iii. Proceed with the installation. If prompted, respond Yes or Yes to All to 
overwrite existing content. 

iv. Select Finish on the last dialog window. 

B. Install SAS IT Resource Management Client 

i. Select the SAS IT Resource Management Client item. 

ii. In the right pane, scroll down and select the Install link. 

iii. Proceed with the installation. If prompted, respond Yes or Yes to All to 
overwrite existing content. 

iv. Select Finish on the last dialog window. 

Deploy and Configure the SAS IT Management Solutions Core Components 
Data Tier Software 
The software that was installed with the SAS IT Management Solutions Core Components Data Tier is 
deployed and configured at this point. 

Note:  A full version of the Java Development Kit (JDK) is required for this step. For Windows 
platforms supporting SAS IT Management Solutions Core Components Data Tier, the 
recommended version is 1.4 2_05. 

From a Windows command prompt, change directory to the Upgrade subdirectory in the SAS ITMS 
Core Components Data Tier installation directory. This should be similar to the default location 
shown below: 

C:\Program Files\SAS\SASITMSCoreComponents\3.1\DataTier\Upgrade 

This subdirectory contains a batch script file called DeployConfig_Ant.bat. This will deploy and 
configure the newly installed software to the SAS Configuration directory. Invoke the script and pass 
it two parameters – the first is the root configuration path and the second is the configuration name. 

For example, given a configuration directory that is C:\SAS\ITRM, the parameters would be: C:\SAS 
for the root configuration path and ITRM for the configuration name. The resulting example 
command is shown below: 

DeployConfig_Ant.bat C:\SAS ITRM 

This should run for about 15 seconds. 

Verification 
To verify that this step has completed properly, you can change directory to your configuration 
location (for example, C:\SAS\ITRM\Lev1\SASMain\SASITMSCoreComponents\OMR) and verify 
that there is new content for the supplied metadata xml. You can also view the contents of 
C:\SAS\ITRM\Lev1\Utilities\SASITMSCoreComponents\Upgrade. You should verify that a 
Windows batch script file called runUpgrade.bat exists. This is what you will use in the next section 
to upgrade the existing repository. 

Upgrade the Existing 3.1 Repository 
The contents of your existing SAS IT Resource Management 3.1 repository must be upgraded so that 
they are compliant with SAS IT Resource Management 3.1.1 software.  

The upgrade process connects to the SAS Metadata Server to update the ITMS repository. Because the 
SAS Metadata Server was stopped to install new software it is necessary to start it before proceeding. 

From a Windows command prompt, change directory the Upgrade subdirectory in your configuration 
utilities location. This should be similar to the default location given below: 
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C:\SAS\ITRM\Lev1\Utilities\SASITMSCoreComponents\Upgrade 

This subdirectory contains a Windows batch script file called runUpgrade.bat. Invoke this script by 
submitting runUpgrade.bat from the command line. The SAS log generated by the SAS job called 
by this script is located in C:\SAS\ITRM\Lev1\Utilities\SASITMSCoreComponents\logs 
(assuming the default Upgrade subdirectory location specified above). View this log to verify that the 
upgrade process completed without errors. 

Please note that this process may take a long time. Although typical times to upgrade an ITMS 
repository have been 30 minutes or less, the upgrade process may take two hours or more to 
complete, depending on the size of the existing repository.  

The key factors that should be considered are which Adapters were originally deployed and how many 
populated IT data marts the ITMS repository contains. Because of the volume of metadata associated 
with it, the SMF Adapter has the highest overhead associated with it. This is the case for deployments 
of only the required tables as well as both required and extended tables. 

Once this task is completed and you have verified that there are no errors in the SAS log, you have a 
viable SAS IT Resource Management 3.1.1 ITMS repository. 
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Chapter 9: Installing SAS IT Service Level Management 2.1 
Instructions for the installation and configuration of your SAS IT Service Level Management Server 
are included as part of the SAS IT Service Level Management Client located on the SAS IT 
Management Client Components CD, which can be found in your Installation Kit. 
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Chapter 10: Post-Installation Configuration for SAS/IntrNet 
Software 

If you received SAS/IntrNet software and have completed the installation of SAS 9.1.3 Foundation, 
you have successfully installed the SAS server components of SAS/IntrNet software (referred to as the 
SAS/IntrNet server).  

The SAS Client-Side Components CD that is included in your SAS software order contains 
SAS/IntrNet client components and documentation for SAS/IntrNet software. 
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Chapter 11: Post-Installation Setup for the Metabase Facility 
In Version 7 of the SAS System, the SAS/EIS Metabase facility was converted to the V7 Common 
Metadata Repository. The Common Metadata Repository is a general-purpose metadata management 
facility that provides common metadata services to various metadata-driven applications.  

Using the Common Metadata Repository requires a one-time setup of the system the repository 
manager. If the repository manager was set up in a previous release it may not need to be set up again. 
The steps in the following sections should be completed before you attempt to use the Metabase 
Facility. For Metabase Facility users who were using a release prior to Version 7, using the Common 
Metadata Repository requires a conversion. For more information, see the Version 8 OLAP Server 
Topic “Converting Legacy Metabases.”  

Setting Up the System Repository Manager Files 
Complete the following steps to set up the necessary system repository manager files. You must have 
write access to SASHELP in order to specify the system repository manager.  

Note:  This process sets the default location for the repository manager for your site. Individual 
users may specify their own repository manager location by following the steps below and 
not selecting the Write values to system registry check box. 

1. Create a directory that will be dedicated exclusively to the storage of repository manager files, for 
example: !SASROOT\RPOSMGR.  

This directory should not be used to store other SAS files.  

2. At a SAS command line, type REPOSMGR and then select Setup Repository Manager.  

3. In the Repository Manager Setup window, Library will default to RPOSMGR. For Path, specify the 
path from Step 1, above, and then select the Write values to system registry check box. Then 
select OK.  

4. In the resulting dialog window, select Yes to generate the necessary repository manager files.  

This completes the setup for the System Repository Manager. You can create additional repository 
managers (a user repository manager, for example) by repeating the steps above and by using a 
different path.  

Registering the SASHELP Repository in the Repository Manager 
The SASHELP repository is used in various samples, including the SAS/EIS Report Gallery templates. 
Before beginning the steps below, a repository manager must be created (see previous section). 
Complete the following steps to register the SASHELP repository in the Repository Manager:  

1. At a SAS command line, type REPOSMGR and then select Repository Registration.  

2. In the Repository Registration window, select New.  

3. In the Register Repository (New) window, type SASHELP (in uppercase) in the Repository field, 
and then type the full directory path where the CORE catalog is located in the Path field, for 
example:  

!SASROOT\CORE\SASHELP 

4. In the Description field, you can type any character string (for example, SASHELP Repository). 
Select OK to close the Register Repository (New) window. Select Close to exit the Repository 
Registration window.  
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Note:  Repositories cannot span multiple directories because the path cannot contain concatenated 
directories. If you have existing metabases in concatenated directories, you should copy the 
metabases to a single path that will be referenced as a repository.  

Converting Version 6 SAS/EIS Metabases to Version 8 Repositories 
For step-by-step instructions on converting Version 6 metabases to Version 8 repositories, please 
refer to the topic “Converting existing SAS/EIS metabases” in the SAS/EIS online Help. 
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Chapter 12: Post-Installation Configuration for SAS Metadata 
Server 

After you apply SAS 9.1.3 Service Pack 4, add a nickname for the SAS Information Maps LIBNAME 
Engine. The engine nickname (INFOMAPS) is not defined by default in SAS 9.1.3 Service Pack 4. This 
needs to be done for the Microsoft Windows 32-bit operating systems supported by the Information 
Maps engine. 

You can add the engine nickname to your SAS catalog using the following SAS code: 

proc nickname cat=sashelp.core; 
     add nickname=infomaps 
     module=sasioime 
     release="9" 
     desc="SAS Information Maps LIBNAME Engine" 
     prefered 
     engine; 
run; 
quit; 
 
For information about how to start a SAS session in order to use this code, please refer to 
http://support.sas.com/onlinedoc/913/getDoc/en/hostwin.hlp/startsas.htm. 
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Chapter 13: Post-Installation Instructions for National Language 
Support (NLS)  

This chapter contains information on post-installation configuration for Asian and European 
language support.  

Important:  To run a localized SAS image, your operating system must be configured to use a 
Windows regional setting appropriate to the localized image. You may experience 
unexpected results if the regional setting and the localized image are not consistent.  
 
If multiple SAS localizations have been installed on the system, you may need to 
change the regional setting for each localized SAS image before invocation. For 
information on how to change or to use regional settings, refer to your Microsoft 
Windows documentation. 

Chinese, Japanese, and Korean DBCS Support 
This section explains how to change the default settings for the DBCSLANG and DBCSTYPE system 
options and how to specify Asian font catalogs. 

Note:  The DBCSLANG and DBCSTYPE system options (described in the next section) should be used 
to set locale for Asian character sets only. The LOCALE and ENCODING system options, 
described in the SAS Help System, are used to set locale for European languages. 

Changing the Default DBCSLANG and DBCSTYPE Option Settings 
When you install SAS 9.1.3 Foundation and choose to load NLS language translations, the installation 
automatically sets default values for the DBCSLANG and DBCSTYPE system options based on the 
language selection and platform. For example, if you install Primary Japanese on Windows 2000, the 
configuration file (!sasroot\nls\ja\sasv9.cfg) sets DBCSLANG to JAPANESE and DBCSTYPE to 
PCMS. 

Changing the Configuration Files for Unicode Server  
There are two configuration files. The first, c:\program files\sas\sas 9.1\sasv9.cfg, 
points to the second, c:\program files\sas\sas 9.1\nls\1d\sasv9.cfg. To run SAS as a 
Unicode Server, edit the configuration files for your system with the following changes: 

1. DBCS settings are in the second configuration file above. Comment-out the DBCSLANG and 
the DBCSTYPE options in that file. For example: 

/* -DBCSTYPE PCMS   */ 
/* -DBCSLANG JAPANESE */ 

2. Add the ENCODING option and set the value to UTF8 (ENCODING=UTF8): 

-ENCODING=utf-8   

Asian Font Catalogs 
The default configuration files for Asian language editions already contain font definitions. (However, 
the configuration file for DBCS extensions does not contain font definitions.) Asian font catalogs 
reside in subdirectories (by language) for easy installation. If you want to change the font catalog, you 
can specify it in either the configuration file or in your SAS session. 
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With the exception of Traditional Chinese fonts, Asian fonts reside in the SASHELP.FONTS catalog. 
The default configuration file for the Traditional Chinese language edition already contains font 
definitions. (However, please note that the configuration file for DBCS extensions does not contain 
font definitions.) To use Traditional Chinese fonts, you can specify them either in the configuration 
file or in your SAS session. 

Installing Traditional Chinese Fonts 
To use Traditional Chinese fonts, you must install the Traditional Chinese localization. You will also 
need to modify your configuration file, as described in the following section. 

Specifying the Font Catalog in the Configuration File for Traditional Chinese Fonts 
If you are not running a Traditional Chinese localization but you want to use the Traditional Chinese 
fonts, you need to modify the configuration file to set GFONTx to 

   -set gfontx !SASROOT/nls/zt/font-name 

In this statement, 

• x represents a value from 0-9. 
• font-name represents the name of the font catalog you want to use. 

Specifying the Font Catalog in a SAS Session for Traditional Chinese Fonts 
To specify the font catalog in a SAS session, submit the following LIBNAME statement:  

-libname gfontx !sasroot\nls\langcode\font-name 

In this statement, 

• x represents a value from 0-9. 
• font-name represents the name of the font catalog you want to use. 

European Language Support 
The following sections explain different methods for configuring your system for locale, describe how 
to set up your local session to transfer data to a remote session, and provide a list of devmap and 
keymap values that match the locales on your operating system.  

Configuring SAS 9.1.3 for Locale 
If you want to configure your SAS session for a locale other than the default locale, you have two 
methods from which to choose to achieve that goal. This section explains those methods. 

Changing the Default LOCALE Option Setting 
When you install SAS 9.1.3 Foundation and you choose to load NLS language translations, the 
installation automatically sets the LOCALE system option to the default value for the language 
installed. The LOCALE option is set in the system configuration file for each language installed.  

For example, !SASROOT\nls\fr\sasv9.cfg sets LOCALE to French_France by default.  

If you want to change the default locale setting for SAS, you can set the LOCALE system option to the 
appropriate language in your system configuration file.  

For example, you can edit !SASROOT\nls\fr\sasv9.cfg and change -locale French_France 
to -locale French_Canada. 
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Running SAS in a Different Locale 
To set the locale for SAS 9.1.3 at your site, add the LOCALE system option to your configuration file. 
You can find a list of locale values in the SAS 9.1 National Language Support (NLS) User’s Guide. 

When you read or write a file, SAS 9.1.3 expects the data in the external files to be in the session 
encoding. To specify a different encoding, refer to the documentation for the ENCODING system 
option in the FILENAME, INFILE, or FILE statement in the SAS 9.1 National Language Support 
(NLS) Use’s Guide. 

When LOCALE is set, the ENCODING system option will be set to an encoding that supports the 
language for the locale. SAS 9.1.3 expects user data to be in the encoding that matches the ENCODING 
option. If you prefer an encoding other than the most common encoding for the locale, you can also 
set the ENCODING system option in the configuration file. 

When the ENCODING option is set, the TRANTAB option will always be set to match the ENCODING 
system option. The transport format trantabs (translation tables), set by the TRANTAB option, are 
used by the CPORT and CIMPORT procedures to transfer SAS data files. These trantabs are also used 
by the UPLOAD and DOWNLOAD procedures for transferring files and catalogs, remotely submitting 
code to the server, and returning logs and listings to the client.  

The Output Delivery System (ODS) will create output using the encoding that matches the ENCODING 
system option. If you would like your output created using a different encoding, please refer to the 
documentation for the Output Delivery System. 

For more information, refer to the Base SAS 9.1 Procedures Guide in base SAS software for 
documentation about PROC CPORT and PROC CIMPORT. Refer to the SAS/CONNECT 9.1 User’s 
Guide for documentation on PROC UPLOAD and PROC DOWNLOAD.  

Additional Information 
Depending on the applications you run, additional setup may be required for your system. Refer to 
the following sections for more information about configuring your system to run with alternate 
locales. 

Locale Setup on the Remote Server  
Note:  The %LS( ) macro was introduced in SAS 9.1. This macro replaced the functionality of the 

Locale Setup Window that was used in previous releases.  

References to “SAS System 9” in the following section refer to all releases of SAS software 
from SAS System 9 forward. 

If you are running SAS System 9 as both your client and server sessions, it is not usually necessary to 
run the %LS( ) macro to do any further locale setup. The locale of a server should be compatible with 
the locale of your client session; otherwise, your data may be corrupted. 

If your SAS System 9 client is connecting to a session running a release of SAS prior to SAS System 9, 
you can use the %LS( ) macro to set up the remote SAS environment for data transfer. As the Locale 
Setup Window did in previous releases, the %LS( ) macro copies the host-to-host translation tables 
from the LOCALE catalog into SASUSER.PROFILE. The %LS( ) macro does not set the encoding for 
the SAS session.  

If you use SAS/CONNECT to connect to a remote SAS server, you will need to set up the server 
session for the locale that the SAS client is using. You must set up the server after signing on to the 
remote session from the client. 

The following examples show how to set locale for remote connections: 

Connecting SAS System 9-to-SAS System 9: Use the LOCALE option at startup. The LOCALE 
option value of the SAS client and server sessions should be the same. For example, 
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    sas -locale Spanish_Spain 

Connecting SAS System 9 and a previous release of SAS:  

• SAS System 9 receives the data: Use the LOCALE option on the SAS System 9 side at start up.  

Example: sas -locale Spanish_Mexico 

• Previous release receives the data: Start SAS System 9 with the LOCALE option at start up. 

Example: sas -locale Spanish_Guatemala 

Then use the %LS( ) macro in SAS System 9 to set up the host-to-host translation tables on the 
previous release after connection is established. For example, submit the following code from the 
Program Editor: 

%ls(locale=Spanish_Guatemala, remote=on);  

Devmaps and Keymaps for SAS/GRAPH Software 
If you are running SAS/GRAPH software and you want to display non-ASCII characters, set the 
appropriate devmaps and keymaps to match your current encoding. The devmap and keymap 
entries are located in the SASHELP.FONTS catalog. To get the correct devmaps and keymaps for 
your encoding, you should use the %LSGRAPH macro.  

There are two ways in which the %LSGRAPH macro automatically sets up an environment: 

• copies the devmap and keymap entries that match your encoding to the GFONT0.FONTS 
catalog  

• changes the name of the entry to the name DEFAULT so the devmaps and keymaps will be 
loaded for you. 

The following example uses %LSGRAPH to set the correct devmap and keymap (WLT2) for a Polish 
user on the Windows platform: 

libname gfont0 'your-font-library'; 
%lsgraph(wlt2); 
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Here is a list of the devmaps and keymaps that match the locales on your platform:  
 

Locale                                  Devmap and  
                                             Keymap Name 

 Locale                                  Devmap and  
                                             Keymap Name 

Arabic_Algeria wara  German_Switzerland wlt1 

Arabic _Bahrain wara  Greek_Greece wgrk 

Arabic _Egypt wara   Hebrew_Israel wheb 

Arabic_Jordan wara  Hungarian_Hungary wlt2 

Arabic_Kuwait wara   Icelandic_Iceland wlt1 

Arabic_Lebanon wara  Italian_Italy wlt1 

Arabic_Morocco wara  Italian_Switzerland wlt1 

Arabic_Oman wara   Latvian_Latvia wbal 

Arabic_Qatar wara  Lithuanian_Lithuania wbal 

Arabic_SaudiArabia wara  Norwegian_Norway wlt1 

Arabic_UnitedArabEmirates wara  Polish_Poland wlt2 

Arabic_Tunisia   wara  Portuguese_Brazil wlt1 

Bulgarian_Bulgaria wcyr  Portuguese_Portugal wlt1 

Byelorussian_Belarus wcyr  Romanian_Romania wlt2 

Croatian_Croatia  wlt2  Russian_Russia w cyr 

Czech_CzechRepublic wlt2  Serbian_Yugoslavia wcyr 

Danish_Denmark wlt1  Slovakian_Slovakia wlt2 

Dutch_Belgium wlt1  Slovenian_Slovenia wlt2 

Dutch_Netherlands wlt1  Spanish_Argentina wlt1 

English_Australia wlt1  Spanish_Bolivia wlt1 

English_Canada wlt1  Spanish_Chile  wlt1 

English_HongKong wlt1  Spanish_Colombia wlt1 

English_India wlt1  Spanish_CostaRica wlt1 

English_Ireland wlt1  Spanish_DominicanRepublic wlt1 

English_Jamaica wlt1  Spanish_Ecuador wlt1 

English_NewZealand wlt1  Spanish_ElSalvador wlt1 

English_Singapore wlt1  Spanish_Guatemala wlt1 

English_SouthAfrica wlt1  Spanish_Honduras wlt1 

English_UnitedKingdom wlt1  Spanish_Mexico wlt1 

English_UnitedStates wlt1  Spanish_Nicaragua wlt1 

Estonian_Estonia wbal  Spanish_Panama wlt1 

Finnish_Finland wlt1  Spanish_Paraguay wlt1 

French_Belgium wlt1   Spanish_Peru wlt1 

French_Canada wlt1  Spanish_PuertoRico wlt1 

French_France wlt1  Spanish_Spain wlt1 

French_Luxembourg wlt1  Spanish_UnitedStates wlt1 

French_Switzerland wlt1  Spanish_Uruguay wlt1 

German_Austria wlt1  Spanish_Venezuela wlt1 

German_Germany wlt1  Swedish_Sweden wlt1 

German_Lichtenstein wlt1  Turkish_Turkey wtur 

German_Luxembourg wlt1  Ukrainian_Ukraine wcyr 
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Chapter 14: Post-Installation Setup for SAS OLAP Server  
SAS OLAP Server includes client components that are used outside of your SAS installation. These 
components are available on the SAS Client-Side Components CD, Volume 1 and are described 
below.  

For more information on using SAS OLAP Cube Studio and SAS OLAP Server Monitor, refer to the 
SAS OLAP Server Administrators Guide in the SAS 9.1 Help and Documentation. For more 
information on the Open OLAP Client, see the online help for SAS OLAP Server. The online help also 
contains more information on the post-installation configuration for V8 SAS OLAP Server. 

Open OLAP Client for SAS/MDDB Server 3.0 
SAS OLAP Server Software includes an OLE DB provider, Open OLAP Server. The Open OLAP Server 
allows you to access, update, and manipulate MDDB data on your SAS System from OLE DB- and 
ADO-compliant applications on Windows platforms.  

If you will be using the Open OLAP Server to access SAS MDDBs, you need to install only the Open 
OLAP Client. The component should be installed on the Windows platform where your OLE DB-
compliant applications will run. 

SAS OLAP Cube Studio 
SAS OLAP Cube Studio, a component of SAS OLAP Server, is designed for the IT professional 
responsible for building and maintaining OLAP cubes in a corporate environment. SAS OLAP Cube 
Studio integrates with SAS Management Console and SAS Data Integration Studio to provide the tools 
needed to maintain the OLAP environment.  

If you will be creating and maintaining SAS OLAP cubes, you need to install SAS OLAP Cube Studio. 
The component should be installed on the Windows platform that you will use to create your cubes. 

SAS OLAP Server Monitor for SAS Management Console 
SAS OLAP Server Monitor is a plug-in component for SAS Management Console. You use SAS OLAP 
Server Monitor to monitor the status of your running SAS OLAP Servers.  

If you need to monitor the status of your SAS OLAP Servers, you need to install SAS OLAP Server 
Monitor. The component should be installed on the same Windows platform as SAS Management 
Console. 
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Chapter 15 – Post-Installation Configuration for SAS OpRisk 
VaR Software 

Follow the steps below to configure SAS OpRisk VaR on your Windows system. 

Initialize a SAS Data Store for SAS OpRisk VaR 3.2 
You can create a data store using the Configuration Editor. If you want to run the macros by hand 
to create a data store, follow these steps: 

1. Skip this section if you have SAS OpRisk VaR version 2.5 and would like to migrate it to SAS 
OpRisk VaR version 3.2, and go to “Migrate SAS OpRisk VaR 2.5 to a SAS Data Store for SAS 
OpRisk VaR 3.2.” 

2. Run the 'orvsetup' macro in SAS: 
orvsetup(); 

3. Run the 'orvdb_create' macro in SAS:  

orvdb_create(DATA_ROOT=C:\VarTablesNew, 
APPLY_CONSTRAINTS=true);  

The DATA_ROOT parameter represents a new directory you have created for the SAS OpRisk 
VaR data tables. You do not need to modify any other parameters. 

4. If there are no other errors in the log, your data store is now initialized. Skip the next section 
and go to “Install/Start the SAS Share Server for SAS OpRisk VaR 3.2.” 

Migrate SAS OpRisk VaR 2.5 to a SAS Data Store for SAS OpRisk VaR 3.2 
In order to perform the steps listed below, you must have a computer that has the following 
software installed: 

• Base SAS with SAS/ACCESS 
• SAS OpRisk VaR 3.2 
• Software required by SAS/ACCESS to connect to the database being used by SAS OpRisk 

VaR 2.5 (such as Oracle client if connecting to an Oracle database) 

1. Skip this section if you already performed the steps in the section entitled “Initialize a SAS 
Data Store for SAS OpRisk VaR 3.2.” 

2. Perform one of the following steps: 

• If your old database is Oracle, run the OpRiskVaRSeqOracle.ddl script from within 
your Oracle database. It will fill in the VAR_SEQUENCES table appropriately. 

• If your old database is DB2, run the OpRiskVaRSeqDB2.ddl script from within your 
DB2 database. It will fill in the VAR_SEQUENCES table appropriately. 

3. Create a libref that points to your SAS OpRisk VaR 2.5 database. Here is an example: 

libname VARDAT25 oracle user=sasuser 
password=sasuser1 path='alien' schema=sasuser; 

See SAS/ACCESS for details about creating a libref to other external databases. 
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Note: The machine from which you are running this must have the specific database 
software on it that allows the connection to be satisfied. In the example above, the 
machine must have at least Oracle client software on it, with the service name 
'alien' defined. 

4. Run the 'orvsetup' macro in SAS: 

%orvsetup(); 

5. Run the 'orvdb_migrate' macro in SAS: 

%orvdb_migrate(DATA_ROOT=C:\VarTables, 
OLDDATA_LIBREF=VARDAT25); 

The DATA_ROOT parameter represents a new directory you have created for SAS OpRiskVaR 
data tables. The OLDDATA_LIBREF parameter represents the libref set up in step 2 above. 

6. If there are no other errors in the log, your database is now migrated to the SAS OpRisk VaR 
3.2 data store. Proceed to the next section. There is also no need to use the Data Store 
Creation tab of the Configuration Editor. 

Install/Start the SAS Share Server for SAS OpRisk VaR 3.2 
1. Skip this section if you are setting up a single-user configuration. 

2. The complete instructions for this step (for the Windows platform) may be found in the file 
Configuring a SAS Share Server Service.pdf. For the UNIX platform, please 
consult the SAS/SHARE documentation. 

SAS OpRisk VaR 3.2 Client Configuration 
When you have performed an Administrator install of SAS OpRisk VaR Java Client 3.2, you must 
run the Configuration Editor to set up an opriskvar.ini file. The generated file will be 
requested during the client (non-administrator) installs of SAS OpRisk VaR Java Client 3.2. 

Post Migration information  
1. If you did not migrate a SAS OpRisk VaR 2.5 data store, ignore this section. 

2. After migration, you are required to re-validate the previously loaded SAS OpRisk VaR 2.5 
data versions using the SAS OpRisk VaR 3.2 application before the versions can be used 
successfully in the SAS OpRisk VaR 3.2 application. 

3. No VaR results are migrated. You must re-run VaR calculations on the final tab for each 
project. This is due to the fact that VaR is calculated differently in version 3.2 than in version 
2.5. If you prefer the VaR calculation method in SAS OpRisk VaR 2.5, you must keep using 
that version of the application. 
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Chapter 16: Post-Installation Configuration of SAS Solution 
Adapters for SAP 

Configuring SAS Activity-Based Management Adapter 6.2 for SAP R/3 
SAS Activity-Based Management Adapter 6.2 for SAP R/3 requires extensive installation setup before 
it can be used. For detailed instructions and configuration information, please visit 
http://support.sas.com/documentation/onlinedoc/abm/index.html and refer to the 
Configuration Guide for SAS® Activity-Based Management Adapter 6.2 for SAP R/3. 

Configuring SAS Financial Management Adapter for SAP 
SAS Financial Management Adapter for SAP requires extensive installation setup before it can be 
used. For detailed instructions and configuration information, please visit 
http://support.sas.com/documentation/onlinedoc/mgmtsolutions/adapter13.pdf 
and refer to the SAS Solutions Adapter 1.3 for SAP: User's Guide. 

Configuring SAS Human Capital Management Adapter for SAP 
SAS Human Capital Management Adapter for SAP requires extensive installation setup before it can 
be used. For detailed instructions and configuration information, please visit 
http://support.sas.com/documentation/onlinedoc/mgmtsolutions/adapter13.pdf 
and refer to the SAS Solutions Adapter 1.3 for SAP: User's Guide. 

Configuring SAS IT Management Adapter 2.7 for SAP 
SAS® IT Management Adapter 2.7 for SAP requires extensive installation setup before it can be used. 
For detailed instructions and configuration information, please visit 
http://support.sas.com/documentation/onlinedoc/mgmtsolutions/sap27config.pdf 
and refer to the Configuration Guide for SAS® IT Management Adapter 2.7 for SAP. 
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Chapter 17: Installing SAS/SECURE Software Client 
Components 

SAS/SECURE software includes client components that non-SAS System client applications can use 
to communicate with a SAS server in a secure environment. To use encryption between a non-SAS 
System client and a SAS server with SAS/SECURE software licensed, you must install the 
SAS/SECURE client components on the client machine. The SAS/SECURE client components are 
available in the SAS/SECURE folder accessible through the SAS Software Navigator.  

Note: This installation is not necessary if the SAS System is your client. The SAS System installs 
the components that it needs as part of the SAS System install process.  

SAS/SECURE for Windows Clients 
The SAS/SECURE components needed by Windows clients can be installed by running the SAS 
Software Navigator to access the SAS/SECURE Windows Client Components. The secwin.exe 
executable available in this folder installs the files necessary for the IOM Bridge for COM to use the 
CryptoAPI algorithms. 

SAS/SECURE for Java Clients 
The SAS/SECURE components for Java clients provide encryption support for Java applications. You 
can incorporate this support into applications that are written using the following components:  

• SAS/SHARE driver for JDBC  
• SAS/CONNECT driver for Java  
• IOM Bridge for Java  

The SAS/SECURE components needed by Java clients can be installed by running the SAS Software 
Navigator to access the SAS/SECURE Java Component. This folder contains two JAR files that enable 
Java clients to use the CryptoAPI algorithms: 

• sas.rutil.jar - should be copied to the location where the client you are running gets 
started 

• sas.core.jar - included in case you do not already have one however, this will probably 
not be needed 

The sas.rutil.jar file should be copied to the location(s) where you installed each of the following 
products. They are listed below with their respective default installation locations. 

• for SAS MC, <SAS_HOME>\SASManagementConsole\9.1 
• for OLAP Cube Studio, <SAS_HOME>\SASOlapCubeStudio\9.1 
• for SAS Data Integration Studio, <SAS_HOME>\SASETLStudio\9.1 
• for SAS Information Map Studio, <SAS_HOME>\SASInformationMapStudio\1.0 

In these examples, <SAS_HOME> is specified through the SAS Software Navigator, with C:\Program 
Files\SAS as the default. 

After the file is copied where you need it, you can use algorithms other than sasproprietary. 
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Chapter 18: Post-Installation Setup for SAS/SHARE Software 
This chapter discusses the use of the TCP/IP access methods with SAS/SHARE software. TCP/IP is 
the access method supported for SAS 9.1.3 on Windows. For information about the access methods 
supported by other systems, please visit 
http://support.sas.com/documentation/onlinedoc/ and refer to Communications Access 
Methods for SAS/CONNECT 9.1 and SAS/SHARE 9.1.  

Using the TCP/IP Communications Access Method 
Communication between a SAS/SHARE server and user is handled by the TCP/IP communications 
access method, which is a part of SAS 9.1.3 that uses underlying communications software to 
exchange messages and data. The TCP/IP access method requires Microsoft’s TCP/IP Network 
Protocol communications software. 

Note:  The APPC access method is no longer supported for the Windows operating system. 

To use the TCP/IP access method, you must have the supporting software on each workstation on 
which a SAS/SHARE server or user will execute.  

System Configuration for the TCP/IP Access Method 
SAS/SHARE software supports Microsoft’s TCP/IP Network Protocol, which is provided with 
Windows. 

To define server names in the TCP/IP SERVICES file, complete the following steps: 

1. Locate the SERVICES file. 

This file is located under the \windows or \winnt directory paths depending on the specific 
Windows operating system and upgrade method. For example, under a machine configured with 
a Windows 2000 operating system, the directory path is named 

<drive letter>:\winnt\system32\drivers\etc  

2. Specify the server names and port assignments. 

Each SAS/SHARE server that runs on a network must be defined as a service in the SERVICES 
file. Each entry in this file associates a service name with the port number and protocol used by 
that service. An entry for a SAS/SHARE server has the form: 

<server name> <port number>/<protocol> # <comments> 

The server name must be 1-8 characters in length. The first character must be a letter or 
underscore. The remaining seven characters can include letters, digits, underscores, the dollar ($) 
sign, or the at (@) sign. The port number must be above 1024, as any port number equal to or less 
than 1024 is reserved. The protocol must always be TCP. 

An entry for a server with the name MKTSERV might look like this: 

mktserv 5000/tcp # SAS server for Marketing and Sales 

The server name is specified with the SERVER= option in the PROC SERVER statement in the 
server’s SAS session and in the PROC OPERATE and LIBNAME statements in user and server 
administrator programs. If the server name is not defined, you must use __port#, for example, 
server= __5012. 

For more information about the options used with PROC SERVER and PROC OPERATE 
procedures, please refer to the SAS/SHARE 9.1 User's Guide. 
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Client-Side Components 
SAS/SHARE software includes client components that are used outside of your SAS installation. 
These components are available on the SAS Client-Side Components CD and are described below: 

SAS/SHARE Data Provider  
The SAS/SHARE data provider enables you to access, update, and manipulate SAS data using OLE 
DB- and ADO-compliant applications on Windows platforms.  

SAS ODBC Driver  
The SAS ODBC driver enables you to access, update, and manipulate SAS data from ODBC-compliant 
applications on Windows platforms.  

SAS/SHARE Driver for JDBC  
The SAS/SHARE driver for JDBC enables you to write applets, applications, and servlets that access 
and update SAS data. The Java Tools package that includes the SAS/SHARE driver for JDBC also 
includes the SAS/CONNECT driver for Java. If you are writing Java programs using these interfaces, 
you may also want to use the tunnel feature. This optional feature can be used with the Java applets 
you write to solve some common configuration problems.  

SAS/SHARE SQL Library for C  
The SAS SQL Library for C provides an application programming interface (API) that enables your 
applications to send SQL queries and statements through a SAS/SHARE server to data on remote 
hosts. 

NLS Information 
Sites that develop or support international applications that use SAS/SHARE software should refer to 
the chapter Post-Installation Instructions for National Language Support (NLS) on page 38. 
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Chapter 19: Post-Installation Setup for SAS/STAT Software  
The Web application SAS/STAT Power and Sample Size is provided with SAS/STAT software, but it is 
installed separately. The application is available on the SAS Mid-tier Components CD. Detailed 
installation instructions and a list of required SAS products can also be found there.  

Overview 
SAS/STAT Power and Sample Size is a user interface that provides power and sample size 
computations. The application includes tasks for determining sample size and power for a variety of 
statistical analyses, including the following: 

• t tests 
• confidence intervals of means 
• proportions 
• equivalence testing 
• ANOVA 
• linear models 
• survival analysis 

The application provides multiple input parameter options, stores results in a project format, displays 
power curves, and produces appropriate narratives for the results. 

Because SAS/STAT Power and Sample Size is a Web application, it requires Web server software. To 
run a Java virtual machine, the Web server must contain a servlet container. Specifications for the 
servlet container are in the SAS/STAT Power and Sample Size Installation Instructions. 

Configuration 
SAS/STAT Power and Sample Size can be installed in either of two configurations: local or remote. 
The configurations differ in terms of where the necessary components are expected to run. The 
application requires these three components: the Web server, the SAS software, and the Microsoft 
Internet Explorer Web browser. 

Local (Standalone) Configuration 
In the local configuration, SAS/STAT Power and Sample Size can run in a standalone manner, that is, 
without access to the Internet. The Web server, the SAS software, and Microsoft Internet Explorer 
must all be installed on the same machine. Because Internet Explorer is required, this configuration is 
only available on PCs running Windows operating systems.  

The Apache Tomcat servlet container is available as an optional part of the SAS/STAT Power and 
Sample Size installation. It can be used as a Web server in this standalone environment. You may also 
choose to install the Web server and servlet container from a third-party source. 

Remote Configuration 
In a remote configuration, the application, Web server, and Web browser are not on the same 
machine. The Web server and servlet container must be installed from a third-party source. 

Additional SAS software products are required—specifically, SAS/CONNECT and a license for either 
SAS Integration Technologies or SAS/IntrNet. The SAS server administrator installs and runs the 
SAS/CONNECT spawner program. The administrator also provides information to the person 
installing SAS/STAT Power and Sample Size, who needs to know the machine name of the SAS server, 
the port for which the spawner is configured, and whether a user name and password are required by 
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the SAS server. If the SAS server is running on a UNIX system, the person who installs SAS/STAT 
Power and Sample Size will also need the SAS command that the spawner uses to submit the job to 
SAS. 

Installation 
SAS Foundation software should be installed before the SAS/STAT Power and Sample Size 
application is installed. Full installation instructions are provided on the Mid-tier Components CD. 
The installation process copies the application WAR (Web archive) file to a directory on the Web 
server. It does not deploy the application to the Web server itself. The person who installs the 
application must do that as a separate step. 

Deployment in the Web Server 
After installation, the application’s WAR file must be deployed to the Web server. The deployment 
procedure varies depending on the Web server. For more information, please see the documentation 
for your specific Web server. If you are using an Apache Tomcat server that was installed as part of 
the application, please see your SAS/STAT Power and Sample Size Installation Instructions for more 
details. 

Making the Application Available to Users 
When installation and deployment of the application is completed, the Web address (URL) of the 
SAS/STAT Power and Sample Size application must be provided to users. The syntax of the URL 
varies among Web servers. The URL for the local (standalone) configuration is described in the 
SAS/STAT Power and Sample Size Installation Instructions. 
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Chapter 20: Post Installation Instructions for SAS/Text Miner  
The XCMD option, the ability to submit "x" operating system commands from a SAS process, is 
necessary for the proper functioning of Text Miner with SAS Enterprise Miner 5.1 or 5.2.  

Therefore, it is necessary to include -xcmd and -noxwait in the Workspace Server SAS command 
used to launch the actual spawned session. It is also necessary to modify the object spawner controls 
and add the invocation parameter -allowxcmd to the object launch. 

 To complete the configuration, perform the following steps: 

Modify the Object Spawner launch 
1. Stop the Object Spawner by stopping the service or canceling the script. 

2. Backup then edit ObjectSpawner.bat. 

3. Insert the option -allowxcmd prior to the -sasLogfile option to the three command 
lines. To do this, Replace "-sasLogfile" with "-allowxcmd -sasLogfile" effectively 
adding the -allowxcmd parameter to three command lines. 

4. Save changes. 

5. If installed as a service, perform steps 6-8. Please note that this might be necessary if you are 
running scripts, if you still receive the same error after trying steps 1-4. 

6. In a command window, go to the Object Spawner directory into your application server 
directory for your configuration.  
E.g., C:\SAS\[plan name]\Lev1\SASMain\ObjectSpawner 

7. Type in objectspawner remove (this removes the existing service).  

8. Type in objectspawner install (this re-installs the new service). 

9. Start the Object Spawner by service start or script. 

Open the SAS Management Console and Edit the SAS command for the 
Workspace Server 

1. Select "+" to expand the Server Manager node. Fully expand all three levels of SASMain. 

2. Highlight the lowest level, SASMain - Workspace Server. Using the right mouse button, 
select Properties. 

3. On the Options tab, in the Command field, replace the existing text with: 
sas -config "c:\SAS\[plan name]\Lev1\SASMain\sasv9.cfg" -xcmd -
noxwait 

4. Select OK to save changes. 
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